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LỜI NÓI ĐẦU 

Trong thời đại ngày nay, công nghệ thông tin được ứng dụng rộng rãi trong 

mọi lĩnh vực, đặc biệt là trong công tác công an. Để quản lý, xây dựng và khai 

thác hiệu quả các hồ sơ, văn bản, dữ liệu, người sử dụng không chỉ cần có 

chuyên môn nghiệp vụ mà còn phải trang bị kiến thức nền tảng về Tin học, bao 

gồm: sử dụng thành thạo máy tính, mạng Internet; nắm vững quy trình thiết kế, 

xây dựng văn bản, dữ liệu; soạn thảo nội dung thuyết trình; thực hiện tính toán 

và thống kê số liệu… 

Nhằm hỗ trợ công tác giảng dạy môn "Tin học" và đáp ứng nhu cầu học tập 

của sinh viên, Trường Đại học Cảnh sát nhân dân đã tổ chức biên soạn tài liệu 

Bài tập tình huống “Hệ thống bài tập cơ bản và nâng cao môn Tin học”. Tài liệu 

này bao gồm các nội dung chính: 

Chương 1. Microsoft Word; 

Chương 2. Microsoft Excel; 

Chương 3. Microsoft PowerPoint. 

Hệ thống bài tập giúp sinh viên củng cố kiến thức đã học, đồng thời hỗ trợ 

giảng viên trong quá trình giảng dạy, góp phần nâng cao hiệu quả học tập và 

thực hành. 

Trong quá trình biên soạn, nhóm tác giả đã tuân thủ các quy định về thể 

thức trình bày chuyên đề, đồng thời đưa vào nhiều ví dụ minh họa thực tế. Tuy 

nhiên, khó tránh khỏi những thiếu sót, vì vậy, chúng tôi mong nhận được những 

ý kiến đóng góp quý báu từ quý thầy cô và sinh viên để tài liệu ngày càng hoàn 

thiện hơn. 

      Trường Đại học CSND 
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Chương 1 

MICROSOFT WORD 

I. BÀI TẬP THỰC HÀNH 

BÀI 1. THAO TÁC CƠ BẢN 

- Khởi động Microsoft Word từ màn hình nền Windows. 

- Sử dụng thanh menu Ribbon 

- Chọn lệnh View\Ruler để bật\tắt thước; vào File\Options\Advanced 

chọn đơn vị là Centimeters. 

- Tìm hiểu Home\Font định lại (Font), cỡ chữ (Size), kiểu chữ đậm (Bold), 

màu (Color), chữ nghiêng, chữ gạch chân. 

- Định lại trang văn bản menu Page Layout\Page Setup, khổ giấy (Page 

size): A4, kiểu giấy: đứng, lề trên (Top): 2cm, lề trái (Left): 3cm, lề phải 

(Right): 2cm, lề dưới (Bottom): 2cm. 

- Sử dụng lệnh Undo và lệnh Redo: Nhập vào một đoạn văn bản tùy ý. Xóa 

bỏ một số từ trong đoạn văn bản. Nhấp chọn lệnh Undo, sau đó nhấp chọn Redo. 

Cho nhận xét kết quả. 

BÀI 2. NHẬP VÀ VÀ ĐỊNH DẠNG VĂN BẢNG: KHOẢNG CÁCH 

GIỮA TRƯỚC ĐOẠN VÀ SAU ĐOẠN (SPACING) LÀ 6 PT, KHOẢNG 

CÁCH GIỮA CÁC HÀNG (LINE SPACING) LÀ 1.3 

MỘT SỐ QUY TẮC SOẠN THẢO VĂN BẢN CƠ BẢN 

Ngày nay chúng ta không thể tìm thấy một văn bản chính thức nào của nhà 

nước mà không được thực hiện trên máy tính. Công việc soạn thảo văn bản giờ 

đây đã trở nên quen thuộc với tất cả mọi người. Tuy nhiên không phải ai cũng 

nắm vững các nguyên tắc gõ văn bản cơ bản nhất mà chúng tôi sắp trình bày. 

Bản thân tôi đã quan sát và nhận thấy rằng 90% sinh viên tốt nghiệp các trường 

đại học không nắm vững (thậm chí chưa biết) các qui tắc này! 

Khái niệm ký tự, từ, câu, dòng, đoạn 

Khi làm việc với văn bản, đối tượng chủ yếu ta thường xuyên phải tiếp 

xúc là các ký tự (Character). Các ký tự phần lớn được gõ vào trực tiếp từ bàn 
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phím. Nhiều ký tự khác ký tự trắng (Space) ghép lại với nhau thành một từ 

(Word). Tập hợp các từ kết thúc bằng dấu ngắt câu, ví dụ dấu chấm (.) gọi là câu 

(Sentence). Nhiều câu có liên quan với nhau hoàn chỉnh về ngữ nghĩa nào đó tạo 

thành một đoạn văn bản (Paragraph). 

Trong các phần mềm soạn thảo, đoạn văn bản được kết thúc bằng cách 

nhấn phím Enter. Như vậy phím Enter dùng khi cần tạo ra một đoạn văn bản 

mới. Đoạn là thành phần rất quan trọng của văn bản. Nhiều định dạng sẽ được 

áp đặt cho đoạn như căn lề, kiểu dáng,… Nếu trong một đoạn văn bản, ta cần 

ngắt xuống dòng, lúc đó dùng tổ hợp Shift+Enter. Thông thường, giãn cách giữa 

các đoạn văn bản sẽ lớn hơn giữa các dòng trong một đoạn.  

Nguyên tắc tự xuống dòng của từ 

Trong quá trình soạn thảo văn bản, khi gõ đến cuối dòng, phần mềm sẽ 

thực hiện động tác tự xuống dòng. Nguyên tắc của việc tự động xuống dòng là 

không được làm ngắt đôi một từ. Do vậy nếu không đủ chỗ để hiển thị cả từ trên 

hàng, máy tính sẽ ngắt cả từ đó xuống hàng tiếp theo. Vị trí của từ bị ngắt dòng 

do vậy phụ thuộc vào rất nhiều yếu tố khác nhau như độ rộng trang giấy in, độ 

rộng cửa sổ màn hình, kích thước chữ. Do đó, nếu không có lý do để ngắt dòng, 

ta cứ tiếp tục gõ dù con trỏ đã nằm cuối dòng. Việc quyết định ngắt dòng tại đâu 

sẽ do máy tính lựa chọn. 

Cách ngắt dòng tự động của phần mềm hoàn toàn khác với việc ta sử dụng 

các phím tạo ra các ngắt dòng "nhân tạo" như các phím Enter, Shift+Enter hoặc 

Ctrl+Enter. Nếu ta sử dụng các phím này, máy tính sẽ luôn ngắt dòng tại vị trí đó. 

Nguyên tắc tự xuống dòng của từ là một trong những nguyên tắc quan 

trọng nhất của soạn thảo văn bản trên máy tính. Đây là đặc thù chỉ có đối với 

công việc soạn thảo trên máy tính và không có đối với việc gõ máy chữ hay viết 

tay. Chính vì điều này mà đã nảy sinh một số qui tắc mới đặc thù cho công việc 

soạn thảo trên máy tính. 

Một số quy tắc gõ văn bản cơ bản 

Khi gõ văn bản không dùng phím Enter để điều khiển xuống dòng. 
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Thật vậy trong soạn thảo văn bản trên máy tính hãy để cho phần mềm tự 

động thực hiện việc xuống dòng. Phím Enter chỉ dùng để kết thúc một đoạn văn 

bản hoàn chỉnh. Chú ý rằng điều này hoàn toàn ngược lại so với thói quen của 

máy chữ. Với máy chữ chúng ta luôn phải chủ động trong việc xuống dòng của 

văn bản. 

Giữa các từ chỉ dùng một dấu trắng để phân cách. Không sử dụng dấu 

trắng đầu dòng cho việc căn chỉnh lề. 

Một dấu trắng là đủ để phần mềm phân biệt được các từ. Khoảng cách thể 

hiện giữa các từ cũng do phần mềm tự động tính toán và thể hiện. Nếu ta dùng 

nhiều hơn một dấu cách giữa các từ phần mềm sẽ không tính toán được chính 

xác khoảng cách giữa các từ và vì vậy văn bản sẽ được thể hiện rất xấu. 

Các dấu ngắt câu như chấm (.), phẩy (,), hai chấm (:), chấm phảy (;), 

chấm than (!), hỏi chấm (?) phải được gõ sát vào từ đứng trước nó, tiếp theo là 

một dấu trắng nếu sau đó vẫn còn nội dung. 

Lý do đơn giản của qui tắc này là nếu như các dấu ngắt câu trên không 

được gõ sát vào ký tự của từ cuối cùng, phần mềm sẽ hiểu rằng các dấu này 

thuộc vào một từ khác và do đó có thể bị ngắt xuống dòng tiếp theo so với câu 

hiện thời và điều này không đúng với ý nghĩa của các dấu này. 

Các dấu mở ngoặc và mở nháy đều phải được hiểu là ký tự đầu từ, do đó 

ký tự tiếp theo phải viết sát vào bên phải của các dấu này. Tương tự, các dấu 

đóng ngoặc và đóng nháy phải hiểu là ký tự cuối từ và được viết sát vào bên 

phải của ký tự cuối cùng của từ bên trái./. 
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BÀI 3.  ĐỊNH DẠNG WORDART, CHIA CỘT, TẠO DROP CAP. 

 

hợ nằm 

cách trung 

tâm thành 

phố Cần Thơ khoảng 

1km về phía tây sông 

Hậu, tọa lạc trong 

khuôn viên công ty 

Hội chợ triển lãm 

quốc tế Cần Thơ. Dẫu 

mới tái thành lập 

trong thời gian gần 

đây, nhưng chợ đêm 

Tây Ðô được xem là 

một điểm văn hóa du 

lịch đặc trưng, nổi bật 

và hấp dẫn ở Cần Thơ 

hiện nay. Chợ đêm 

Tây Ðô không chỉ thu 

hút người dân địa ph-

ương mà kể cả du 

khách gần xa. Chợ 

đêm Tây Ðô hiện nay 

có kiến trúc hài hòa 

với cảnh quan môi 

trường xung quanh và 

hoàn toàn mang 

phong cách Nam bộ. 

hợ được chia theo 

từng gian hàng rất 

thứ tự và thông 

thoáng. Cho dù các 

thương dân có bày 

bán nhiều chủng loại 

mặt hàng thì vẫn trông 

rất gọn gàng và thẩm 

mỹ. Ðường đi bộ mua 

sắm trong lòng chợ 

hoàn toàn nhựa hóa và 

thoáng rộng. Các sản 

phẩm tại chợ đêm Tây 

Ðô đều được chọn 

lọc, phong phú và đa 

dạng, đáp ứng mọi 

nhu cầu của du khách 

trong việc lựa chọn 

sản phẩm. Ði kèm với 

hàng hóa, chợ đêm 

Tây Ðô còn có những 

dịch vụ giải trí như: 

trò chơi điện tử, sân 

khấu ca nhạc ngoài 

trời và các chương 

trình giải trí thư giãn 

khác... Đến chợ đêm 

Tây Ðô, du khách sẽ 

thật sự có một chuyến 

du lịch hữu ích và 

những kỷ niệm khó 

phai. Vì ngoài việc 

mua sắm những món 

quà kỷ niệm hay 

những sản phẩm cần 

dùng trong sinh hoạt, 

du khách còn được 

thưởng thức những 

nét đẹp trong đời sống 

sinh hoạt đậm đà bản 

sắc dân tộc mà chỉ có 

ở hạ nguồn sông Mê 

Kông nổi tiếng mới có 

được.

C C 
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BÀI 4. ĐỊNH DẠNG (BULLETS), (NUMBERING) 

 Internet là công cụ khá tiêu biểu để trao đổi thông tin trên các máy 

tính toàn cầu. 

 Internet cung cấp cho các nhà nghiên cứu và nhiều đối tượng khác 

cho thông tin cần thiết. 

 Internet không phân biệt về khoảng cách truy cập. 

 Internet không có một chủ sở hữu kiểm soát. 

 Ban chỉ đạo quốc gia về CNTT. 

 Khoa học CNTT – Viện đại học mở Hà Nội. 

 Viện CNTT Đại học Cần Thơ. 

 Trung tâm Ngoại ngữ-Tin học thành phố Cần Thơ.. 

1) Internet là công cụ khá tiêu biểu để trao đổi thông tin trên các máy 

tính toàn cầu. 

2) Internet cung cấp cho các nhà nghiên cứu và nhiều đối tượng khác 

cho thông tin cần thiết. 

3) Internet không phân biệt về khoảng cách truy cập. 

4) Internet không có một chủ sở hữu kiểm soát. 
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BÀI 5. VẼ HÌNH AUTOSHAP 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

BÀI 6. NHẬP CÔNG THỨC TOÁN HỌC 

 Tìm giới hạn của những hàm số sau đây 

 a)
ax

ax
xf






22

)(     ax      

 b)
x

x
xf

sin

4sin
)(      0x   

 c)
12

456
)(

2






x

xx
xf    

2

1
x    

 d)
x

x
xf

sin21

cos21
)(




    

4


x  

LỢI ÍCH CỦA VIỆC THỰC HIỆN HACCP 

LỢI ÍCH VỚI CHÍNH PHỦ 

1) Cải thiện sức khỏe cộng đồng. 

2) Nâng cao hiệu quả và kiểm soát 

thực phẩm. 

3) Giảm chi phí cho sức khỏe cộng 

đồng. 

4) Tạo điều kiện thuận lợi cho sự 

phát triển thương mại 

 

LỢI ÍCH VỚI 

NGƯỜI TIÊU DÙNG 

1. Giảm nguy cơ các bệnh truyền qua 

thực phẩm. 

2. Nâng cao nhận thức về vệ sinh cơ bản. 

3. Tăng sự tin cậy vào việc cung cấp thực 

phẩm. 

4. Cải thiện chất lượng cuộc sống (sức 

khỏe và kinh tế - xã hội) 

Bộ nhớ ngoài 

 

Bộ nhớ trong 

BỘ XỬ LÝ TRUNG TÂM 

 
Bộ điều khiển Bộ số học/lôgic 

Thiết bị vào Thiết bị ra 
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BÀI 7: THỰC HIỆN ĐỊNH DẠNG CHỈ SỐ TRÊN VÀ CHỈ SỐ DƯỚI: 

 

 

 

 

 

 

BÀI 8. CHÈN HÌNH, ĐỊNH DẠNG HÌNH VÀO VĂN BẢN 

KHÁI NIỆM VỀ NHỮNG THÀNH PHẦN CƠ BẢN NHẤT CỦA MÁY TÍNH 

Trong số chúng ta chắc không ai là không từng được sở hữu 1 hay ít nhất 

là 1 bộ máy vi tính. Nhưng thực tế lại 

cho thấy rằng 1 hoặc ít nhất là 1 trong 

cộng đồng sử dụng tin học lại không hiểu 

rõ về những gì đang nằm trong cái máy 

tính mà chúng ta đang sử dụng, làm việc 

và gặp hàng ngày. Hôm nay mạn phép 

mở chủ đề này nhằm mục đích "xóa mù tin học" cho những gì mà chúng ta còn 

thiếu sót. Mù chỗ nào xóa chỗ ấy, chắc chắn có những phần bạn có thể đã biết 

và, nhưng cũng có những phần mà chúng ta lại chưa biết. Vậy hãy cùng nhau 

trau dồi thêm nhưng gì được xem là cơ bản nhất sau đây. 

1- Hệ thống  

Khi bạn làm chủ một máy tính, tức bạn đang sỡ hữu một hệ thống tinh vi 

và phức tạp. Đó là một hệ thống bao gồm CASE (thùng chứa hay còn gọi là vỏ 

máy). Thùng máy có rất nhiều kiểu và kích cỡ. Các thành phần điện tử sẽ được 

gắn vào thùng chứa bằng các kết nối như ốc vít, hộc đựng, các lỗ dành cho các 

cổng và thiết bị vào/ra. 

2- Bo mạch chủ (motherboard) hay còn gọi la 

mạch hệ thống. Có rất nhiều thành phần linh kiện 

H2SO4; m2, m3; 0C, U=RI2 

2x5 + 5x3 + 6x2 – x -1 =0 
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điện tử được gắn vào bo mạch, còn 1 số khác có thể được tích hợp/hàn luôn vào 

bo mạch. Thường bo mạch được cấu thành bởi các vi mạch, tụ, chip và có các 

khe cắm cho memory, sound card, graphic card... hoặc socket (đế cắm) cho bộ 

vi xử lý. 

 

3- Bộ vi xử lý (processor) viết tắt của Central 

Processing Unit (CPU) chứa đựng và thực thi các 

chỉ thị cơ bản cho việc tổ chức 1 máy tính. Bộ vi 

xử lý chứa đựng 2 thành phần: thành phần điều 

khiển (Control unit ) và thành phần tính toán logic 

(Arithmetic Logic Unit). 

Bộ vi xử lý hoạt động theo một chu kỳ được gọi là 

Machine Cycle gồm: Fetch - Decode - Execute- Store có thể hiểu đơn giàn là 

"đưa ra điều kiện - mã hóa - thực thi- đưa về bộ nhớ". Vòng xoay này được bộ vi 

xử lý thực hiện và đếm nên chúng ta có khái niệm về xung nhịp. Mỗi 1 xung 

nhịp (1 giây) thì CPU thực thi được 1 vòng lệnh ta gọi là hertz. Như vậy ngày 

nay với bộ xử lý 3.2 Ghz thì máy tính có thể xử lý được 3 triệu 200 nghìn lệnh 

trong vòng 1 giây. 

 

 

 

 

 

  

BẠN ĐÃ SỞ HỮU MỘT BỘ MÁY TÍNH CHƯA ? 
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BÀI 9. TẠO BẢNG 

DANH SÁCH HỌC VIÊN 

STT Họ và tên Ngày sinh Giới tính Nơi sinh 

1 Nguyễn Thanh Hùng 20/12/1978 Nam Hậu Giang 

2 Phạm Văn Dũng 12/09/1972 Nam Cần Thơ 

3 Thiệu Thị Kim Chi 24/12/1970 Nữ Vĩnh Long 

4 Trần Thị Diễm 18/10/1975 Nữ Trà Vinh 

5 Lê Hùng Lâm 12/11/1976 Nam An Giang 

 

THÔNG BÁO 

 

  

C
H

Ứ
N

G
 C

H
Ỉ 

A
B

C
 

TRUNG TÂM NGOẠI NGỮ - TIN HỌC TP.CẦN THƠ 

 

* Giảng 

viên uy tín, 

nhiều kinh 

nghiệm. 

 

* Thi 

CCQG sau 

khi kết thúc 

khóa học. 

Kỹ năng Giáo trình học Ngày học 

ANH 

VĂN 

 LIFE – LINES, SUPER – 

KIDS. 

 PERSON TO PERSON. 

 TACTICS FOR LISTENING. 

Thứ 2, 4, 6 

hoặc thứ 3, 5, 

7. 

TIN 

HỌC 

 WIN, WORD, EXCEL, 

POWER POINT, 

INTERNET. 

 PASCAL, ACCESS, 

VISUAL FOX, JOOMLA, 

DREAMWEVER. 

Thứ 2, 4, 6 

hoặc thứ 3, 5, 

7. 
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BÀI 10. SỬ DỤNG ĐIỂM DỪNG CỦA TAB TRÊN THƯỚC 

DANH SÁCH 

 

 STT Họ và tên Địa chỉ Số điện thoại 

 1 Nguyễn Văn Thành 85, Trà Nóc 07103.222.111 

 2 Nguyễn Thanh Thúy 91, Ninh Kiều 07103.732.688 

 3 Trần Thanh Tâm 90, Phong Điền 07103.444.555 

 4 Lê Minh Hưởng 32, Bình Thủy 07103.555.111 

 5 Thái Gia Bảo 23, Thốt Nốt 07103.828.321 

   

HỒ SƠ HỌC VIÊN DỰ THI 

Họ tên: .........................................................................................................................  

Ngày sinh ...................................................... Nơi sinh: ...............................................  

Địa chỉ: ......................................................... Điện thoại: ............................................  

Số chứng minh thư: .....................................................................................................  

 

BÀI 11:  AUTOCORRECT 

Trong BÀI TẬP 3; Dùng lệnh EDIT\REPLACE thay thế dấu “,” thành 

dấu “;” ; và tạo AUTOCORRECT khi gõ TN thì đổi thành Trà Nóc, khi gõ 

NK thì đổi thành Ninh Kiều, khi gõ PĐ thì đổi thành Phong Điền, khi gõ BT 

thì đổi thành  Bình Thủy, khi gõ TN thì đổi thành Thốt Nốt. 
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BÀI 12. MAILMERGE 

Tạo 2 tập tin PHIEUDUTHI.DOCX và DANHSACHHOCVIEN.DOCX 

(tạo hai tập tin riêng biệt), sử dụng chức năng Mail Merge (trộn thư). 

1. Tạo tập tin PHIEUDUTHI.DOCX 

 

SỞ GIÁO DỤC VÀ ĐÀO TẠO  

TRUNG TÂM NGOẠI NGỮ - TIN HỌC 

 

 

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc 

PHIẾU DỰ THI  

Khóa ngày         tháng      năm    

Môn:  Tin học Trình độ: A  

Họ và tên:  

Ngày sinh:  

Nơi sinh:  

Là thí sinh:  Trung tâm Ngoại ngữ - Tin học. 

Số báo danh:  

Địa điểm thi:  Trung Tâm Ngoai Ngữ - Tin học. 

 (Thí sinh ghi rõ họ và tên) 

                                                        ……………, ngày      tháng       năm    

                                                              Giám Đốc 

 

 

  

 

Ảnh 

3 x 4 
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 2. Tạo tập tin DANHSACHHOCVIEN.DOCX 

SBD HỌ VÀ TÊN NGÀY SINH NƠI SINH 

1 Trịnh Văn Trung 03/01/1984 Cần Thơ 

2 Lâm Hoàng Anh 04/01/1979 Vĩnh Long 

3 Lâm Đại  05/01/1984 Cần Thơ 

4 Huỳnh Hồng Nguyệt 07/01/1985 Kiên Giang 

5 Trần Thị Minh Ánh 08/01/1980 Hà Nội 

6 Nguyễn Thị Mai Phương 09/01/1982 TP. HCM 

7 Trần Minh Thuỳ 12/01/1981 Vĩnh Long 

8 Mạc Thị Thu Hường 16/01/1970 Hải Dương 
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BÀI 13: Soạn thảo văn bản sau 

 

Mô hình mạng Wi-Fi cơ bản gồm thiết bị phát (wireless ADSL router, wireless router – bộ định 

tuyến - hoặc access point) và các thiết bị thu nhận tín hiệu đầu cuối (card mạng Wi-Fi). Tùy theo 

hạ tầng mạng, nhu cầu sử dụng và không gian lắp đặt mà bạn chọn thiết bị mạng không dây cho 

phù hợp. 

Thiết bị đầu phát 

Access point hoạt động như bộ chuyển mạch mạng (switch) với 

mục đích chia sẻ kết nối Wi-Fi nên chỉ có vài tính năng đơn giản, 

các chế độ bảo mật như mã hóa WEP64/128 bit, WPA/WPA-PSK 

hoặc chuẩn xác thực 802.11x (tham khảo chi tiết bài “Mạng Wi-Fi” 

trong số này). Wireless router cũng có chức năng chia sẻ kết nối Wi-

Fi nhưng được trang bị những tính năng bảo mật tốt hơn, tăng cường tính năng mà router ADSL 

chưa có. 

Các wireless router hiện nay đều được tích hợp tường lửa (Firewall) với nhiều chính sách bảo 

mật. Ngoài ra, tùy nhu cầu mà bạn có thể lựa chọn wireless router có tích hợp các tính năng nổi 

bật như mạng riêng ảo (VPN), VoIP, cổng mở rộng có khả năng giao tiếp với các thiết bị ngoại 

vi (thiết bị lưu trữ, máy in)... Wireless ADSL router cũng được trang bị những tính năng bảo 

mật tương tự wireless router nhằm bảo vệ mô hình kết nối mạng tốt hơn. Ngoài ra, wireless 

ADSL router còn đóng vai trò của modem/router ADSL (cổng RJ-11) nên bạn đọc không cần 

phải trang bị thêm. 

Chọn chuẩn WLAN 

Tùy mục đích và không gian sử dụng, các chuẩn 802.11g và 802.11n thường được cân nhắc để 

lựa chọn; tham khảo các chuẩn mạng Wi-Fi trong bài “Mạng Wi-Fi”. Mô hình mạng Wi-Fi 

chuẩn 802.11g thích hợp cho việc chia sẻ kết nối Internet máy tính, thiết bị di động, máy chơi 

game giải trí... Mạng Wi-Fi chuẩn 802.11n với băng thông rộng, vùng phủ sóng tốt và khả năng 

can nhiễu thấp thích hợp cho việc xây dựng một hệ thống mạng phục vụ nhu cầu giải trí đa 

phương tiện, trình diễn phim ảnh chất lượng cao (HD, full HD…) hoặc chia sẻ dữ liệu với dung 

lượng lớn mà vẫn đảm bảo chất lượng cùng độ tin cậy cao. 
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SẢN PHẨM THÔNG SỐ KỸ THUẬT 

Cisco 

Linksys 

E3000-AP 

 Wi-Fi: 802.11a/b/g/n, Wi-Fi MIMO, 6 anten trong. 

 Bảo mật: Mã hóa WPA2, WPA2-Enterprise, WPA-

Enterprise, WPA. Tường lửa SPI. Xác thực 802.1x, xác 

thực qua Radius. 

 Cổng giao tiếp ngoài: 4 Ethernet 10 /1100 /1000Mbps, 1 

USB, 1 WAN. 

 Tính năng: Cisco Connect, DHCP server, VPN, Parental 

control, Quality of Service (QoS), Lọc địa chỉ MAC. 

 

BÀI 14: Soạn thảo văn bản sau 

hành phố Cần Thơ nằm ở trung tâm đồng bằng 

sông Cửu Long, giữa một mạng lưới sông ngòi 

chằng chịt Cần Thơ tiếp giáp với 5 tỉnh: phía 

bắc giáp An Giang và đông bắc giáp Đồng Tháp, phía 

nam giáp Hậu Giang, phía tây giáp Kiên Giang, phía 

đông giáp Vĩnh Long. Cần Thơ có nhiều hệ thống sông 

ngòi kênh rạch như sông Hậu, sông Cần Thơ, kênh Thốt 

Nốt, rạch Ô Môn...  

hí hậu Cần Thơ điều hoà dễ 

chịu, ít bão. Quanh năm 

nóng ẩm, không có mùa lạnh. 

Mùa mưa kéo dài từ tháng 5 đến tháng 

11, mùa khô từ tháng 12 tới tháng 4 năm 

sau. Nhiệt độ trung binh là 27ºC. Thành 

phố Cần Thơ có 3 bến cảng có thể tiếp nhận tàu trên 10.000 tấn phục vụ 

cho việc xếp nhận hàng hóa dễ dàng. Từ xa xưa Cần Thơ đã được coi là 

trung tâm lúa gạo của miền Tây Nam bộ, hiện nay là một trong những nơi 

sản xuất và xuất khẩu gạo chính của cả nước. Với đất đai phì nhiêu, bên 

T 

K 

Le Hoai Duong
New Stamp



17 

cạnh thế mạnh về cây lúa và cây ăn quả các loại, Cần Thơ còn có nguồn 

thủy sản khá phong phú, chủ yếu tôm cá nước ngọt và chăn nuôi: lợn, gà, 

vịt. Các ngành công nghiệp hiện có chủ yếu là điện năng (nhà máy điện 

Trà Nóc, 33.000 kw); kỹ thuật điện, điện tử, hoá chất, may, da và chế biến 

nông sản, thủy sản... là thế mạnh của thành phố.  

ịa danh Cần Thơ có xuất xứ từ tên “cầm thi giang” (sông thơ, đàn) cho thấy 

đây là vùng văn hoá sông nước. Con 

sông gắn liền với mọi hoạt động kinh 

tế, văn hoá cư dân. 

Nét độc đáo tự nhiên và kiến trúc đô 

thị của Cần Thơ là mạng lưới kênh 

rạch. Kênh rạch cũng là "đường phố", 

nó mang vẻ đẹp cho một đô thị lớn 

từng được mệnh danh là Tây Đô. Cần Thơ lại có vẻ đẹp bình dị nên thơ của làng 

quê sông nước, dân cư tập trung đông đúc, làng xóm trù phú núp dưới bóng dừa. 

Cần Thơ nổi tiếng với bến Ninh Kiều, vườn cò Bằng Lăng. 

 

 

Phú Quốc ................. Cần Thơ....................... Côn Đảo __________ 1.590.000 VND 

Cần Thơ ................... Sóc Trăng .................... Bạc Liêu __________ 2.300.000 VND 

Cần Thơ ................... Bạc Liêu ...................... Cà Mau ___________ 3.500.000 VND 

Mỹ Tho .................... Bến Tre........................ Cần Thơ __________ 4.000.000 VND 

  

Đ 

 

ĐẾN CẦN THƠ ĐI NHỮNG ĐÂU ? 

 

 Chợ  nổi Cái Răng. 

 Vườn cò Bằng Lăng. 

 Nhà cổ Bình Thủy. 

 Vườn Mỹ Khánh. 

 Bến Ninh Kiều. 

KHUYẾN MÃI 50% 
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BÀI 15.  ĐỊNH DẠNG VÀ TRANG TRÍ BẢNG, CHÈN HÌNH VÀO BẢNG 

KẾT QUẢ THI TIN HỌC CHỨNG CHỈ A 

TT HỌ VÀ TÊN 
NGÀY 

SINH 
NƠI SINH 

ĐIỂM 

L
Ý

 

T
H

U
Y

Ế
T

 

W
O

R
D

 

E
X

C
E

L
 

1  Lê Hoàng Nam 20/12/1975 Cần Thơ 6 5 3 

2  Trương Trường Giang 08/09/1974 Sóc Trăng 5 4 2 

3  Vũ Thị Kim Loan 01/10/1973 Cần Thơ 7 6 3 

4  Nguyễn Thị Hằng 06/09/1974 Cần Thơ 5 3 2 

5  Hồ Thanh Lâm 09/10/1972 Hậu Giang 7 4 3 

6  Nguyễn Thanh Sơn 24/04/1972 Thốt Nốt 6 3 2 

7  Bùi Thị Mỹ Đào 04/10/1973 Vĩnh Long 8 5 3 

8  Lê Lâm Đạt 02/11/1972 Đồng Tháp 7 5 2 

 

BÀI 16: Soạn thảo văn bản 

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc 

BIÊN BẢN 

ĐỐI CHIẾU CÔNG NỢ VÀ THANH LÝ HỢP ĐỒNG 

SỐ: 93/HDMB-PTTS 

Hôm nay, ngày 10 tháng 09 năm 2011, đại diện hai bên là: 

BÊN A: CÔNG TY COCACOLA 

- Địa chỉ : 99 Lý Tự Trọng, Thành phố Cần Thơ. 

- Điện thoại : 071.809999. 

- Do Ông : Trần Thanh Thanh, Phó Giám đốc làm đại diện. 

BÊN B: CÔNG TY PEPSICOLA  

Le Hoai Duong
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- Địa chỉ : 77 Trần Hưng Đạo, Thành phố Cần Thơ. 

- Điện thoại : 071.807777. 

- Do Ông : Trần Tuấn Tuấn, Giám đốc làm đại diện. 

Hai bên tiến hành đối chiếu chứng từ và thanh lý hợp đồng số 93/HDMB-PTTS 

ngày 08/09/2010 gồm các điều khoản sau: 

Điều 1: Dựa vào điều 1 của hợp đồng, bên A đã giao hàng cho bên B gồm : 

TÊN HÀNG ĐVT SỐ LƯỢNG THÀNH TIỀN 

- Đường trắng  ................ Tấn ..................... 200.50 .................................... 100.000 

- Bột ngọt Vedan ............ Tấn ....................... 25.00 ...................................... 60.000 

- Bột ngọt A-One ............ Tấn ..................... 100.00 .................................... 220.000 

- Vàng SJC...................... Kg ........................ 10.25 .................................... 123.000 

Tổng cộng: 503.000 

Điều 2: Bên B đã thanh toán tiền hàng cho bên A. 

1. Phiếu thu 452 ......................... 10/03/2009 .......................... 200.000 USD 

2. Phiếu thu 4526+457+459 ....... 11/03/2009 .......................... 200.000 USD 

3. Phiếu thu 463 ......................... 12/03/2009 .......................... 110.000 USD 

Tổng Cộng: 510.000 USD 

Điều 3: Cân đối công nợ giữa hai bên. 

 - Tính hết ngày 15/09/2011, bên A còn nợ lại bên B: 7.000 USD. Bên A sẽ 

hoàn lại cho bên B ngay sau khi biên bản được hai bên ký. 

 - Sau khi bên A thanh toán xong, hợp đồng được thanh lý. 

Biên bản được lập thành 02 bản có giá trị ngang nhau, mỗi bên giữ 01bản. 

 ĐẠI DIỆN BÊN A ĐẠI DIỆN BÊN B 

 (Ký và ghi rõ họ tên ) (Ký và ghi rõ họ tên ) 
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BÀI 17: Soạn thảo văn bản 

TÊN CƠ QUAN, TC CHỦ QUẢN (1) 

TÊN CƠ QUAN, TỔ CHỨC (2) 
CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc 

Số:       /GGT- … (3)…. …. (4)…. , ngày ….. tháng ….. năm 20… 

GIẤY GIỚI THIỆU 

-------------- 

 ..............................................(2)  ...................... trân trọng giới thiệu:  

Ông (bà)  ................................................. (5)  ...................................................................  

Chức vụ: .................................................  ........................................................................  

Được cử đến: .......................................... (6)  ...................................................................  

Về việc: ...................................................  ........................................................................  

 ................................................................  ........................................................................  

Đề nghị Quý cơ quan tạo điều kiện để ông (bà) có tên ở trên hoàn thành nhiệm vụ. 

Giấy này có giá trị đến hết ngày ............. ./.  

 

Nơi nhận: 

- Như trên; 

- Lưu: VT.  

QUYỀN HẠN, CHỨC VỤ CỦA NGƯỜI 

KÝ 

 

(Chữ ký, dấu) 

 

Họ và tên  

 Ghi chú: 

(1) Tên cơ quan, tổ chức chủ quản trực tiếp (nếu có).  

(2) Tên cơ quan, tổ chức ban hành văn bản (cấp giấy giới thiệu). 

(3) Chữ viết tắt tên cơ quan, tổ chức ban hành văn bản. 

(4) Địa danh 

(5) Họ và tên, chức vụ và đơn vị công tác của người được giới thiệu. 

(6) Tên cơ quan, tổ chức được giới thiệu tới làm việc. 
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BÀI 18: Soạn thảo văn bản 

TÊN CƠ QUAN, TC CHỦ QUẢN (1) 

TÊN CƠ QUAN, TỔ CHỨC (2) 

 

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc 

Số:       /BB- … (3)….  

BIÊN BẢN  

………… (4) …………..  

-------------- 

Thời gian bắt đầu .............................................................................................................  

Địa điểm ..........................................................................................................................  

Thành phần tham dự ...............................  ........................................................................  

Chủ trì (chủ tọa): ....................................  ........................................................................  

Thư ký (người ghi biên bản): .................  ........................................................................  

Nội dung (theo diễn biến cuộc họp/hội nghị/hội thảo): 

 ................................................................  ........................................................................  

Cuộc họp (hội nghị, hội thảo) kết thúc vào … giờ …, ngày …. tháng … năm… 

THƯ KÝ  

(Chữ ký) 

 

Họ và tên  

CHỦ TỌA  

(Chữ ký, dấu (nếu có)) 

(5) 

Họ và tên  

Nơi nhận: 

- ……….; 

- Lưu: VT, hồ sơ.  

 

 Ghi chú: 

(1) Tên cơ quan, tổ chức chủ quản trực tiếp (nếu có).  

(2) Tên cơ quan, tổ chức ban hành văn bản. 

(3) Chữ viết tắt tên cơ quan, tổ chức ban hành văn bản. 

(4) Tên cuộc họp hoặc hội nghị, hội thảo.  

(5) Ghi chức vụ chính quyền (nếu cần). 
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BÀI 19: Soạn thảo văn bản 

THÔNG TƯ 

Hướng dẫn thể thức và kỹ thuật trình bày văn bản hành chính 

Căn cứ Nghị định số 48/2008/NĐ-CP ngày 17 tháng 4 năm 2008 của 

Chính phủ quy định chức năng, nhiệm vụ, quyền hạn và cơ cấu tổ chức của Bộ 

Nội vụ; 

Căn cứ Nghị định số 110/2004/NĐ-CP ngày 08 tháng 4 năm 2004 của 

Chính phủ về công tác văn thư; 

Căn cứ Nghị định số 09/2010/NĐ-CP ngày 08 tháng 02 năm 2010 của 

Chính phủ sửa đổi, bổ sung Nghị định số 110/2004/NĐ-CP ngày 08 tháng 4 năm 

2004 của Chính phủ về công tác văn thư, 

Bộ Nội vụ hướng dẫn thể thức và kỹ thuật trình bày văn bản hành chính 

như sau: 

Chương 1. 

NHỮNG QUY ĐỊNH CHUNG 

Điều 1. Phạm vi và đối tượng áp dụng  

Thông tư này hướng dẫn thể thức và kỹ thuật trình bày văn bản hành 

chính và bản sao văn bản; được áp dụng đối với các cơ quan nhà nước, tổ chức 

xã hội, tổ chức xã hội - nghề nghiệp, tổ chức kinh tế và đơn vị lực lượng vũ 

trang nhân dân (sau đây gọi chung là cơ quan, tổ chức). 

Điều 2. Thể thức văn bản  

Thể thức văn bản là tập hợp các thành phần cấu thành văn bản, bao gồm 

những thành phần chung áp dụng đối với các loại văn bản và các thành phần bổ 

sung trong những trường hợp cụ thể hoặc đối với một số loại văn bản nhất định 

BỘ NỘI VỤ 

 

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc  

 

Số: 01/2011/TT-BNV Hà Nội, ngày 19 tháng 01 năm 2011  
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theo quy định tại Khoản 3, Điều 1 Nghị định số 09/2010/NĐ-CP ngày 08 tháng 

02 năm 2010 của Chính phủ sửa đổi, bổ sung Nghị định số 110/2004/NĐ-CP 

ngày 08 tháng 4 năm 2004 của Chính phủ về công tác văn thư và hướng dẫn tại 

Thông tư này. 

Điều 3. Kỹ thuật trình bày văn bản  

Kỹ thuật trình bày văn bản quy định tại Thông tư này bao gồm khổ giấy, 

kiểu trình bày, định lề trang văn bản, vị trí trình bày các thành phần thể thức, 

phông chữ, cỡ chữ, kiểu chữ và các chi tiết trình bày khác, được áp dụng đối với 

văn bản soạn thảo trên máy vi tính và in ra giấy; văn bản được soạn thảo bằng 

các phương pháp hay phương tiện kỹ thuật khác hoặc văn bản được làm trên 

giấy mẫu in sẵn; không áp dụng đối với văn bản được in thành sách, in trên báo, 

tạp chí và các loại ấn phẩm khác. 

Điều 4. Phông chữ trình bày văn bản  

Phông chữ sử dụng trình bày văn bản trên máy vi tính là phông chữ tiếng 

Việt của bộ mã ký tự Unicode theo Tiêu chuẩn Việt Nam TCVN 6909:2001. 

Điều 5. Khổ giấy, kiểu trình bày, định lề trang văn bản và vị trí trình bày 

1. Khổ giấy 

Văn bản hành chính được trình bày trên khổ giấy khổ A4 (210 mm x 297 mm). 

Các văn bản như giấy giới thiệu, giấy biên nhận hồ sơ, phiếu gửi, phiếu 

chuyển được trình bày trên khổ giấy A5 (148 mm x 210 mm) hoặc trên giấy mẫu 

in sẵn (khổ A5). 

2. Kiểu trình bày 

Văn bản hành chính được trình bày theo chiều dài của trang giấy khổ A4 

(định hướng bản in theo chiều dài). 

Trường hợp nội dung văn bản có các bảng, biểu nhưng không được làm 

thành các phụ lục riêng thì văn bản có thể được trình bày theo chiều rộng của 

trang giấy (định hướng bản in theo chiều rộng). 

3. Định lề trang văn bản (đối với khổ giấy A4) 
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Lề trên: cách mép trên từ 20 - 25 mm; 

Lề dưới: cách mép dưới từ 20 - 25 mm; 

Lề trái: cách mép trái từ 30 - 35 mm; 

Lề phải: cách mép phải từ 15 - 20 mm. 

4. Vị trí trình bày các thành phần thể thức văn bản trên một trang giấy khổ 

A4 được thực hiện theo sơ đồ bố trí các thành phần thể thức văn bản kèm theo 

Thông tư này (Phụ lục II). Vị trí trình bày các thành phần thể thức văn bản trên 

một trang giấy khổ A5 được áp dụng tương tự theo sơ đồ tại Phụ lục trên. 

Chương 2. 

THỂ THỨC VÀ KỸ THUẬT TRÌNH BÀY VĂN BẢN 

Điều 6. Quốc hiệu 

1. Thể thức 

Quốc hiệu ghi trên văn bản bao gồm 2 dòng chữ: “CỘNG HÒA XÃ HỘI 

CHỦ NGHĨA VIỆT NAM” và “Độc lập - Tự do - Hạnh phúc”. 

2. Kỹ thuật trình bày 

Quốc hiệu được trình bày tại ô số 1; chiếm khoảng 1/2 trang giấy theo 

chiều ngang, ở phía trên, bên phải. 

Dòng thứ nhất: “CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM” 

được trình bày bằng chữ in hoa, cỡ chữ từ 12 đến 13, kiểu chữ đứng, đậm; 

Dòng thứ hai: “Độc lập - Tự do - Hạnh phúc” được trình bày bằng chữ 

in thường, cỡ chữ từ 13 đến 14 (nếu dòng thứ nhất cỡ chữ 12, thì dòng thứ hai 

cỡ chữ 13; nếu dòng thứ nhất cỡ chữ 13, thì dòng thứ hai cỡ chữ 14), kiểu chữ 

đứng, đậm; được đặt canh giữa dưới dòng thứ nhất; chữ cái đầu của các cụm từ 

được viết hoa, giữa các cụm từ có gạch nối, có cách chữ; phía dưới có đường kẻ 

ngang, nét liền, có độ dài bằng độ dài của dòng chữ (sử dụng lệnh Draw, không 

dùng lệnh Underline), cụ thể: 
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CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc  

 

Hai dòng chữ trên được trình bày cách nhau dòng đơn. 

Điều 7. Tên cơ quan, tổ chức ban hành văn bản  

1. Thể thức 

Đối với các Bộ, cơ quan ngang Bộ, cơ quan thuộc Chính phủ; Văn phòng 

Quốc hội; Hội đồng dân tộc, các Ủy ban của Quốc hội hoặc Hội đồng nhân dân 

và Ủy ban nhân dân các cấp; Đoàn Đại biểu Quốc hội tỉnh, thành phố trực thuộc 

Trung ương; Tập đoàn Kinh tế nhà nước, Tổng công ty 91 không ghi cơ quan 

chủ quản. 

Tên cơ quan, tổ chức ban hành văn bản bao gồm tên của cơ quan, tổ chức 

chủ quản trực tiếp (nếu có) (đối với các tổ chức kinh tế có thể là công ty mẹ) và 

tên của cơ quan, tổ chức ban hành văn bản. 

a) Tên của cơ quan, tổ chức ban hành văn bản phải được ghi đầy đủ hoặc 

được viết tắt theo quy định tại văn bản thành lập, quy định chức năng nhiệm vụ, 

quyền hạn và cơ cấu tổ chức bộ máy, phê chuẩn, cấp giấy phép hoạt động hoặc 

công nhận tư cách pháp nhân của cơ quan, tổ chức có thẩm quyền, ví dụ: 

BỘ GIAO THÔNG VẬN TẢI 

 

TẬP ĐOÀN ĐIỆN LỰC VIỆT NAM 

 

HỘI ĐỒNG NHÂN DÂN 

TỈNH NGHỆ AN 

ỦY BAN NHÂN DÂN 

TỈNH THÁI NGUYÊN 

 

b) Tên của cơ quan, tổ chức chủ quản trực tiếp có thể viết tắt những cụm 

từ thông dụng như Ủy ban nhân dân (UBND), Hội đồng nhân dân (HĐND), Việt 

Nam (VN), ví dụ: 

UBND TỈNH QUẢNG BÌNH 

SỞ NỘI VỤ 

 

VIỆN KHOA HỌC XÃ HỘI VN 

VIỆN DÂN TỘC HỌC 
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2. Kỹ thuật trình bày 

Tên cơ quan, tổ chức ban hành văn bản được trình bày tại ô số 2; chiếm 

khoảng 1/2 trang giấy theo chiều ngang, ở phía trên, bên trái. 

Tên cơ quan, tổ chức chủ quản trực tiếp được trình bày bằng chữ in hoa, 

cùng cỡ chữ như cỡ chữ của Quốc hiệu, kiểu chữ đứng. Nếu tên cơ quan, tổ 

chức chủ quản dài, có thể trình bày thành nhiều dòng. 

Tên cơ quan, tổ chức ban hành văn bản trình bày bằng chữ in hoa, cùng cỡ 

chữ như cỡ chữ của Quốc hiệu, kiểu chữ đứng, đậm, được đặt canh giữa dưới tên 

cơ quan, tổ chức chủ quản; phía dưới có đường kẻ ngang, nét liền, có độ dài bằng 

từ 1/3 đến 1/2 độ dài của dòng chữ và đặt cân đối so với dòng chữ. Trường hợp 

tên cơ quan, tổ chức ban hành văn bản dài có thể trình bày thành nhiều dòng… 

 

II. CÂU HỎI TRẮC NGHIỆM 

Câu 1: Để khởi động Word, ta thực hiện: 

A. Start\Accessories. 

B. Start\Programs\Microsoft Office\Microsoft Word 2010. 

C. Kích chuột vào biểu tượng Word 2010 trên màn hình nền Windows. 

D. Cả (B), (C) đều đúng. 

Câu 2: Trong Word, để bật hoặc tắt thước (Ruler), ta thực hiện: 

A. View\Toolbars. B. Insert\Ruler. 

C. View\Ruler. D. Tools\Options. 

Câu 3: Thước (Ruler) được tính theo đơn vị: 

A. cm.      B. mm. 

C. inch.     D. Tùy chọn trong File\Options. 

Câu 4: Trong Word, để lưu tài liệu, ta thực hiện: 

A. File\Save. B. Nhấp biểu tượng . 

C. Nhấn Ctrl + S.  D. Cả (A), (B), (C) đều đúng. 
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Câu 5: Trong Word, để mở file văn bản, ta thực hiện: 

A. Nhấp biểu tượng   B. Nhấn Ctrl + O. 

C. File\Open. D. Cả (A), (B), (C) đều đúng. 

Câu 6: Các biểu tượng trên thanh công cụ  theo thứ tự tương 

đương các tổ hợp phím: 

A. Ctrl+L, Ctrl+R, Ctrl+C, Ctrl+D.          B. Ctrl+L, Ctrl+C, Ctrl+R, Ctrl+J. 

C. Ctrl+L, Ctrl+E, Ctrl+R, Ctrl+J             D. Tất cả đều sai. 

Câu 7: Trong Word, để chọn một câu, ta thực hiện: 

A. Nhấn phím Ctrl và nhấp bất kỳ đâu trong câu. 

B. Nhấn phím Shift kết hợp với các phím mũi tên. 

C. Cả (A), (B) đều đúng. 

D. Cả (A), (B) đều sai. 

Câu 8: Trong Word, nếu thực hiện sai một thao tác, chẳng hạn xóa nhầm 

một từ, ta sử dụng lệnh Undo để: 

A. Hủy bỏ thao tác đó. B. Để xóa văn bản. 

C. Để lưu tài liệu. D. Không thực hiện gì cả. 

Câu 9: Trong Word, để thay đổi kích cỡ chữ (Size), ta chọn: 

A. . B. Home\Font. 

C. . D. Cả (B), (C) đều đúng. 

Câu 10: Trong Word, để tăng cỡ chữ, Ta thực hiện: 

A. Chọn khối văn bản muốn thay đổi, sau đó nhấn tổ hợp phím Ctrl + ]. 

B. Chọn khối văn bản muốn thay đổi, sau đó nhấn tổ hợp phím Ctrl + [. 

C. Chọn khối văn bản muốn thay đổi, sau đó nhấn phím Ctrl + C. 

D. Chọn khối văn bản muốn thay đổi, sau đó nhấn phím Ctrl + V. 

Câu 11: Trong Word, để sao chép văn bản, ta thực hiện: 

Le Hoai Duong
New Stamp



28 

A. Chọn khối văn bản muốn sao chép, sao đó nhấp vào biểu tượng Copy 

, di chuyển điểm chèn đến vị trí cần bản sao, nhấp vào biểu tượng Paste . 

B. Chọn khối văn bản muốn sao chép, sao đó nhấp vào biểu tượng Paste 

, di chuyển điểm chèn đến vị trí cần bản sao, nhấp vào biểu tượng, nhấp 

Copy . 

C. Chọn khối văn bản muốn sao chép, sao đó nhấp vào biểu tượng Copy 

, di chuyển điểm chèn đến vị trí cần bản sao, nhấp vào biểu tượng Cut . 

D. Cả (A), (B), (C) đều sai. 

Câu 12: Trong Word, để tìm kiếm và thay thế một chuỗi ký tự, ta thực hiện: 

A. Edit\Find. B. Ctrl + F. 

C. Ctrl + H. D. Cả (A), (B), (C) đều sai. 

Câu 13: Trong Word, để chèn những ký hiệu đặc biệt không có trên bàn 

phím, ta thực hiện: 

A. Insert\Picture. B. Insert\Symbol. 

C. Insert\Picture\Symbol. D. Insert\Symbol\Picture. 

Câu 14: Trong Word, để chia cột, sau khi chọn phần văn bản cần chia, ta 

thực hiện: 

A. Insert\Columns. B. Page Layout\Columns. 

C. Insert\Break Columns. D. Page Layout\Paragraph. 

Câu 15: Trong Word, để chèn công thức toán học vào văn bản, ta thực hiện: 

A. Format\Font. B. Insert\Symbol. 

C. Insert\Object. D. Insert\Equation. 

Câu 16: Trong Word, để nhập văn bản vào hình Shapes, ta thực hiện: 

A. Không làm được.             B. Nhấp phải chuột vào hình, chọn Insert Text. 

C. Double click vào hình vẽ.   D. Nhấp phải chuột vào hình, chọn Add text. 

Câu 17: Trong Word, để chèn hình vào văn bản, ta thực hiện: 

A. Insert\Pictures. B. Insert\Diagram. 
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C. Insert\Object. D. Insert\Symbol. 

Câu 18: Trong Word, biểu tượng nào dùng để chèn một bảng mới: 

A. . B. . 

C. . D. . 

Câu 19: Trong Word, biểu tượng  dùng để: 

A. Tạo chữ nghệ thuật. B. Tạo Textbox. 

C. Đổi màu chữ. D. Tất cả đều sai. 

Câu 20: Trong Word, để tạo chữ lớn đầu đoạn, ta thực hiện: 

A. Insert\Drop Cap. B. Insert\Tabs. 

C. Insert\Change Case. D. Tất cả đều sai. 

Câu 21: Trong Word, để xem tài liệu trước khi in, ta thực hiện: 

A. File\Print Preview.    C. Cả (A), (B) đều đúng. 

B. File\Print.    D. Cả (A), (B) đều sai. 

Câu 22: Trong Word, để điều chỉnh lề trang in, ta thực hiện 

A. View\Print Layout. B. Layout\Page Setup. 

C. Cả (A), (B) đều đúng. D. Cả (A), (B) đều sai. 

Câu 23: Trong Word, để định dạng đoạn văn bản, ta thực hiện 

A. Page Layout\Paragraph. B. Page Layout\Alignment. 

C. Format\Preview. D. Paragraph\Spacing. 

Câu 24: Trong Word, muốn tạo tiêu đề đầu trang và chân trang, ta thực hiện 

A. View\Header & Footer.                        B. View\Switch Header & Footer. 

C. Header & Footer\Drawing.                   D. Insert\ Header & Footer. 

Câu 25: Trong Word, để chuyển bảng thành văn bản, ta thực hiện: 

A. Tools\Options\Text. B. Layout\Convert to Text. 

C. Table\Convert Table to Text. D. Không thực hiện được. 

Câu 26: Trong Word, để chọn Font chữ, ta nhấn tổ hợp phím 
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A. Ctrl + Shift + F. B. Ctrl + Shift + =. 

C. Ctrl + U. D. Ctrl + B. 

Câu 27: Để thoát khỏi Word, ta nhấn tổ hợp phím: 

A. Alt + F4. B. Ctrl + F4. 

C. Alt + Enter. D. Alt + End. 

Câu 28. Muốn kết thúc Word, ta dùng lệnh nào sau đây? 

A. File/ Exit  B. Table/ Close  

C. Tools/ Exit  D. File/ Close 

Câu 29. Để tạo văn bản mới, ta thực hiện lệnh sau: 

A. Edit/ New  B. File/ New  

C. View/ New  D. Tools/ New 

Câu 30. Muốn lưu một văn bản, ta sử dụng tổ hợp phím nào? 

A. Ctrl + O  B. Ctrl + P  

C. Ctrl + N  D. Ctrl + S 

Câu 31. Để xóa kí tự trong văn bản, ta sử dụng những phím nào trên bàn phím? 

A. Backspace, Delete  B. Delete, Insert 

C. Backspace, End  D. Cả 3 ý trên 

Câu 32. Khi đang soạn thảo văn bản sử dụng bộ gõ Tiếng Việt Vietkey, tổ 

hợp phím Alt + Z có chức năng: 

A. Chuyển chế độ gõ Tiếng Anh sang Tiếng Việt khi đang ở chế độ gõ 

Tiếng Anh. 

B. Chuyển chế độ gõ Tiếng Việt sang Tiếng Anh khi đang ở chế độ gõ 

Tiếng Việt. 

C. Chuyển chế độ bảng mã Unicode sang TCVN3. 

D. Cả A và B đều đúng. 

Câu 33. Trong Word, ta sử dụng lệnh Home/ Font … để: 

A. Tạo bảng  B. Định dạng kí tự  
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C. Chèn hình ảnh  D. Chia cột 

Câu 34. Thuộc tính định dạng ký tự cơ bản gồm có: 

A. Phông chữ  B. Kiểu chữ  

C. Cỡ chữ và màu sắc  D. Cả 3 ý trên 

Câu 35. Trong Word, muốn định dạng trang ta dùng lệnh: 

A. File/ Page Setup  B. Home/ Page Setup  

C. Page Layout/ Page Setup  D. View/ Page Setup 

Câu 36. Muốn mở một file văn bản đã có sẵn, ta dùng lệnh: 

A. File/ New     B. View/ Open      C. File/ Open  D. Edit/ Open 

Câu 37. Để chia một ô thành nhiều ô, ta chọn ô cần tách rồi thực hiện thao tác: 

A. Table/ Split Cells  B. Table/ Select  

C. Layout/ Split Cells  D. Insert/ Split Cells  

Câu 38. Muốn tạo bảng trong Word, ta thực hiện thao tác: 

A. Insert/ Table/ Table  B. Table/ Insert/ Table  

C. Table/ Insert  D. Insert/ Table 

Câu 39. Lệnh Home/Editing/ Find … dùng để: 

A. Thay thế từ, cụm từ  B. Định dạng từ, cụm từ 

C. Tìm kiếm từ, cụm từ  D. Xóa, sửa từ, cụm từ 

Câu 40. Hãy chọn đáp án sai: Để gộp nhiều ô thành một ô, trước hết ta 

chọn số ô cần gộp rồi thực hiện: 

A. Nhấn chuột phải, rồi chọn Merge Cells  

B. Nhấn chọn Windows, rồi chọn Merge Cells 

C. Chọn Layout/ Merge Cells  

D. Chọn trên thanh công cụ 

Câu 41. Trong Word, muốn quay lại thao tác / lệnh vừa thực hiện ta bấm tổ 

hợp phím 

A. Ctrl + Z        B. Ctrl + X     C. Ctrl + V  D. Ctrl + Y 
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Câu 42. Trong Word, tổ hợp phím nào cho phép chọn toàn bộ văn bản: 

A. Ctrl + F      B. Alt + F       C. Ctrl + A  D. Alt + A 

Câu 43. Trong Word, công dụng của tổ hợp phím Ctrl + H là: 

A. Tạo tệp văn bản mới  B. Chức năng thay thế  

C. Định dạng chữ hoa  D. Lưu tệp văn bản 

Câu 44. Trong Word, tổ hợp phím Ctrl + V được dùng để 

A. Cắt một đoạn văn bản                  B. Dán một đoạn văn bản từ Clipboard 

C. Sao chép một đoạn văn bản         D. Cắt và sao chép một đoạn văn bản 

Câu 45. Để chèn tiêu đề trang, ta thực hiện: 

A. Insert/ Header and Footer  B. Tools/ Header and Footer 

C. View/ Header and Footer  D. Format/ Header and Footer 

Câu 46. Trong Word, để sao chép một đoạn văn bản vào Clipboard, ta đánh 

dấu đoạn văn bản đó rồi: 

A. Chọn Home/ Copy  B. Bấm tổ hợp Ctrl + C  

C. A và B đều đúng  D. A và B đều sai 

Câu 47. Trong Word, tổ hợp phím nào cho phép ngay lập tức đưa con trỏ 

về đầu dòng đầu tiên của văn bản 

A. Shift + Home    B. Alt + Home   C. Ctrl + Home  D. Ctrl + Alt + Home 

Câu 48. Trong Word, muốn trình bày văn bản theo khổ giấy ngang trong 

cửa sổ Page Setup ta chọn mục: 

A. Portrait       B. Right           C. Left  D. Landscape 

Câu 49. Khi soạn thảo văn bản, nếu kết thúc 1 đoạn và muốn sang 1 đoạn mới: 

A. Nhấn Ctrl + Enter  B. Nhấn Enter  

C. Nhấn Shift + Enter  D. Không cần nhấn 

Câu 50. Trong Word, tổ hợp phím nào cho phép ngay lập tức đưa con trỏ 

về dòng cuối cùng của văn bản: 

A. Shift + End       B. Ctrl + End      C. Alt + End  D. Ctrl + Alt + End 
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Đạt giải Nhất Nhì Ba Không đạt

Mức cộng 0,3 0,2 0,1 0

Chương 3 

MICROSOFT EXCEL 

I. BÀI TẬP THỰC HÀNH 

BÀI 1: 

Cho vùng dữ liệu sau: 

 
 

                        
  

Câu hỏi:   

1. Đánh STT (001, 002, ...)  

2. Tính cột điểm cộng cho các thành viên giữ chức vụ. 

3. Tính cột điểm thưởng cho các thành viên đạt giải NCKH. 

4. Xếp loại cho các thành viên (5-7: Trung bình, 7-8: Khá, 8 trở lên: Giỏi)  

5. Sắp xếp cột thứ hạng.  

6. Có bao nhiêu bạn có tên bắt đầu bằng chữ "K" có điểm trung bình trên 7? 

7. Tổng điểm của những bạn đạt giải nghiên cứu và đạt loại giỏi trở lên?  

8. Lấy phần nguyên điểm trung bình của tất cả các thành viên. 

9. Sắp xếp thứ hạng từ theo trình tự từ lớn nhất đến nhỏ nhất 

10. Hãy tô màu nguyên dòng các học viên có điểm trung bình từ 7.0 trở lên 

11. Dùng Data Validation để kiểm soát điểm thưởng tối đa là 2 điểm, chia lẻ 

tới 2 số sau dấu thập phân. 

STT Chức vụ
Mã 

ngành
Họ và tên Triết

Tư tưởng

 HCM
XHKH

Đạt giải

 NCKH

Điểm 

thưởng

Điểm

 cộng

Trung

 bình

Thứ 

hạng

Xếp 

loại

Lớp trưởng 0028 Huỳnh Văn An 8.3 7.8 7.7

Học viên 0032 Lê Thanh Bình 6.2 4.5 5.7

Học viên 0021 Nguyễn Cao Cường 3.5 6.2 7.0

Học viên 0022 Lê Văn Đức 6.5 4.8 5.2

Học viên 0137 Trần Thị Giang 6.0 7.3 6.5

Học viên 0044 Trần Nhật Hào 5.4 5.0 4.8

Tiểu đội trưởng 0012 Huỳnh Minh Khang 5.6 7.1 6.4

Tiểu đội phó 0086 Lê Chí Khanh 8.0 8.1 7.9

Bí thư 0123 Phạm Trúc Lam 7.1 7.6 7.1

Lớp phó 0047 Trần Đức Việt 9.0 8.5 8.0

BẢNG ĐIỂM TRUNG BÌNH LỚP B3 - CSĐT - D32S

Lớp trưởng 0,3

Lớp phó 0,3

Tiểu đội trưởng 0,2

Tiểu đội phó 0,2

Bí thư 0,3

Học viên 0

Bảng điểm cộng
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12. Sử dụng Subtotal để tính tổng điểm cộng theo chức vụ của các học viên 

trong lớp. 

13. Sử dụng lệnh VBA để thực hiện yêu cầu ở câu hỏi số 3.   

BÀI 2: 

Cho vùng dữ liệu sau: 

 
 

 
 

 

Câu hỏi: 

1: Sử dụng bảng phụ để điền loại phòng.   

2: Sử dụng hàm thích hợp để điền giá tiền thuê.    

3: Sử dụng hàm thích hợp để điền vào cột với những ai có có ký hiệu V 

hoặc điền 0 với những ai ko có voucher theo bảng 3.    

4: Sử dụng hàm thích hợp để tính số tuần thuê.     

5: Sử dụng hàm thích hợp để tính số ngày lẻ.    

6: Xếp loại phòng theo giá tiền thuê.    

7: Hoàn thành bảng thống kê sau.  

STT Họ và tên người thuê Mã phòng

Loại 

phòng XL phòng Giá tiền Ngày đến Ngày đi Số tuần Ngày lẻ Giảm giá(%) Thành tiền

1 Nguyễn Đức Anh V3-101-STD 20/10/2023 19/11/2023

2 Hồ Trương Trung Chính 207-SUP 01/11/2023 20/11/2023

3 Lê Thế Bảo V3-105-STD 05/10/2023 21/11/2023

4 Hàn Xuân Đạt V2-303-DLX 12/10/2023 22/11/2023

5 Dương Quốc Đạt 301-DLX 18/11/2023 23/11/2023

6 Nguyễn Trần Huy Hoàng 202-SUP 28/10/2023 24/11/2023

7 Nguyễn Tạ Việt Anh V1-501-SUT 03/11/2023 25/11/2023

8 Cao Trần Thê Anh 108-STD 06/10/2023 26/11/2023

9 Nguyễn Thành Đạt V1-404-SUT 10/11/2023 27/11/2023

10 Trịnh Lê Anh Diễn 106-STD 30/10/2023 28/11/2023

Danh sách khách hàng trả phòng ngày 19/11/2023 tại khách sạn X

Loại vouher 1 2 3

Phần trăm giảm 10 20 30

Ký hiệu Loại phòng

STD Standard

SUP Superior

DLX Deluxe

SUT Suit

Bảng 1

Loại phòng Tiền thuê(1 ngày)

Standard 500,000 VND

Superior 800,000 VND

Deluxe 1.500,000 VND

Suit 3.000,000 VND

Bảng 2
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 8: Lọc ra loại phòng Standard có số tuần thuê bằng 4  

9: Tô màu nguyên dòng với khách hàng ở phòng Suit 

10: Dùng Data validation để cho phép nhập các ngày đến trước hoặc trong 

ngày hôm nay. 

11. Đặt mật khẩu cho file excel là: “123@acb” 

BÀI 3 

Cho vùng dữ liệu sau: 

 
 

 

Câu hỏi: 

1. Tính tổng điểm của mỗi học sinh. 

2. Tính điểm trung bình, làm tròn tới số thập phân thứ 2 và tạo 1 cột lấy 

phần nguyên của điểm trung bình. 

3. Điền xếp loại với điểm trung bình: Giỏi từ 9-10, khá 7-9, TB <7. 

4. Tính tiền thưởng. 

5. Tính tổng điểm của vừa mã học sinh DT, vừa xếp loại khá. 

6. Đếm có bao nhiêu bạn điểm cả word và excel >=7. 

Loại phòng Số người thuê Tổng tiền thuê

Standard

Superior

Deluxe

Suit

Bảng thống kê

STT Họ và tên Giới tính Ngày sinh Mã HS Word Excel PPT

Tổng 

điểm Điểm TB

Xếp

loại

Tiền

thưởng

1 Nguyễn Ngọc Kiều Diễm Nữ 08/01/2004 DT02 10 10 8

2 Nguyễn Doãn Trường Nam 23/04/2005 NH08 2 4 6

3 Nguyễn Thảo Huyền Nữ 11/05/2004 XG11 9 7 10

4 Châu Ngọc Hùng Nam 15/08/2004 DT04 7 9 6

5 Phan Thị Nhung Nữ 31/10/2004 DT07 4 8 9

6 Phạm Thị Thùy Trang Nữ 12/09/2004 XG09 9 6 7

7 Trần Trung Triền Nam 20/11/2004 XG17 7 7 7

8 Nguyễn Bảo Chinh Nữ 08/01/2004 XG06 8 6 9

9 Trịnh Lê Anh Diễn Nam 18/04/2004 NH22 5 8 6

10 Nguyễn Doãn Quang Nam 17/09/1998 DT26 9 9 10

DANH SÁCH ĐIỂM TIN

Mã số Giỏi Khá

DT 500,000 VNĐ 500,000 VNĐ

NH 400,000 VNĐ 400,000 VNĐ

XG 300,000 VNĐ 300,000 VNĐ

Tiền thưởng
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7. Lọc tên bạn nào có cả 3 môn >=7. 

8. Lấy phần dư của tổng điểm với điểm của excel. 

9. Lọc và sắp xếp lại tên các bạn nữ theo bảng chữ cái. 

10. Tô màu nguyên dòng với học viên có điểm trung bình thấp nhất lớp. 

11. Dùng Data Validation để chỉ cho phép nhập mộ trong hai giới tính là 

“Nữ” hoặc “Nam” 

BÀI 4: 

Cho vùng dữ liệu sau 

 

 

 

Câu hỏi: 

1: Lập công thức điền cột Môn học dựa vào ký tự chữ trong Mã số và Bảng 

2: Lập công thức điền số tín chỉ dựa vào ký tự số cuối cùng của Mã số. 

3: Lập công thức điền số tiết dựa vào ký tự số cuối cùng của Mã số.  

Biết: Môn học 4 tín chỉ có số tiết học tập là 60 tiết, 3 tín chỉ có số tiết học tập 

là 45 tiết, 2 tín chỉ có số tiết học tập là 30 tiết."     

4: Lập công thức điền Giá giáo trình dựa vào "ký tự số đầu tiên của Mã số", 

"ký tự số của Mã số" và Bảng 2         

STT Mã số Môn học Tín chỉ Số tiết Giá Số lượngXếp hạng giáo trình 
đăng ký
Thời gian

 học
Tổng tiền

1 1-CT-4 Chính trị 50

2 2-CT-4 Chính trị 45

3 1-DTH-2 Dân tộc học 40

4 2-DTH-2 Dân tộc học 42

5 1-THDC-3 Tin học đại cương 47

6 1-TGH-2 Tôn giáo học 52

7 3-CT-4 Chính trị 56

8 2-THDC-3 Tin học đại cương 59

9 2-TGH-2 Tôn giáo học 39

10 3-TGH-2 Tôn giáo học 37

BẢNG ĐĂNG KÝ MUA GIÁO TRÌNH

Tên môn học

CT Chính trị

DTH Dân tộc học

TGH Tôn giáo học

THDC Tin học đại cương

Bảng 1

1 2 3

CT 50.000 45.000 40.000

DTH 40.000 37.000 35.000

TGH 42.000 38.000 32.000

THDC 48.000 44.000 40.000

Giá giáo trình
Mã giáo trình

Bảng 2
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5: Lập công thức điền xếp loại môn học được đăng ký nhiều nhất dựa vào số 

lượng học viên đăng ký môn học        

6: Lập công thức tính thời gian học dựa trên số tiết môn học, biết mỗi tuần 

học viên học 6 tiết. Làm tròn đến đơn vị "Tuần"      

7: Lập công thức tính tổng số tiền của từng loại giáo trình mà học viên đăng 

ký mua. Biết: Tổng tiền = Giá giáo trình  x  Số lượng học viên đăng ký". 

8: Tính các số liệu tại bảng thống kê sau.     

  
  

9:  Lọc ra giáo trình của môn Chính trị có số lượng học viên đăng ký hơn 45. 

10: Tô màu nguyên dòng với môn học có tổng tiền lớn nhất hoặc các môn học 

Chính trị. 

11: Dùng Data Validation để số lượng sách phải là số nguyên dương. 

BÀI 5: 

 

 
 

Môn Chính trị Dân tộc học Tôn giáo học Tin học đại cương

Tổng tiền

Thống kê

Số giáo trình có giá lớn hơn 40,000:

STT Trung đội

Chuyên 

ngành

Quân

 số

Số 

tiểu đội

Số học

viên nữ

Số học 

viên nam lẻ 

ở ghép 

Hệ số 

phụ cấp

Tổng mức 

lương (VNĐ)

1 B3-CSĐT-D32S 52

2 B2-TSCS-D32S 48

3 B1-KTHS-D31S 48

4 B1-CSĐT-D32S 51

5 B2-CSMT-D31S 50

6 B1-ĐTHS-D30S 52

7 B3-TSCS-D32S 48

8 B1-QLHC-D31S 52

9 B2-ĐTHS-D31S 50

10 KTHS-D32S 50

CHI TIẾT LƯƠNG MỘT SỐ TRUNG ĐỘI TẠI TRƯỜNG ĐẠI HỌC CSND NĂM 2023

Mã ngành Chuyên ngành

CSĐT Cảnh sát điều tra

ĐTHS Điều tra Hình sự

QLHC Quản lí hành chính

CSMT Cảnh sát ma túy

KTHS Kĩ thuật hình sự

TSCS Trinh sát cảnh sát

MÃ NGÀNH VÀ CHUYÊN NGÀNH

Khóa D30S D31S D32S

Hệ số phụ cấp 0,6 0,5 0,4

HỆ SỐ PHỤ CẤP THEO TỪNG KHÓA
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Câu hỏi:  

1. Lập công thức cho cột Chuyên ngành và tra tên chuyên ngành trong 

bảng Mã ngành và chuyên ngành. VD:B3-CSĐT-D32S --> Cảnh sát điều tra 

2. Tính số tiểu đội của từng trung đội, biết mỗi tiểu đội tối thiểu 10 học 

viên và chênh lệch với số lượng đó nhỏ nhất có thể. 

3. Tính số học viên nữ mỗi trung đội, biết ngành CSĐT và ĐTHS có 5 

học viên nữ, ngành KTHS có 1 nữ và những ngành còn lại là 4 học viên nữ. 

4. Tính số học viên nam lẻ ở ghép với trung đội khác, biết mỗi phòng ở 

chỉ có tối đa 10 người . 

5. Lập công thức cho cột Hệ số phụ cấp dựa vào bảng Hệ số phụ cấp theo 

từng khóa. 

6. Tính cột Tổng mức lương= Hệ số phụ cấp* Quân số* Hệ số phụ cấp.  

7. Định dạng Tổng mức lương có dấu phẩy ngăn cách phần nghìn. 

8. Thêm một cột thứ hạng, tính thứ hạng tổng mức lương của từng trung 

đội theo thứ tự giảm dần. 

9. Hoàn thành bảng thống kê bằng các phương pháp thích hợp. 

10. Lọc ra các lớp CSĐT hoặc những lớp có tổng mức lương lớn hơn 

40,000,000 VNĐ. 

11. Tô màu nguyên dòng với trung đội có nhiều học viên nữ nhất 

12. Dùng Data Validation kiểm soát tên lớp chỉ được nhập các lớp D31S 

hoặc D32S. 

BÀI 6: 

Cho vùng dữ liệu sau: 

 

Mã ngành CSĐT ĐTHS QLHC CSMT KTHS TSCS

Tổng số lương

Số trung đội

BẢNG THỐNG KÊ Lương cơ bản 1800000

STTMã ngành Họ và tên Chuyên ngành

Lương cơ

bản Hệ số Phụ cấp

Tiền 

thưởng Tổng tiền

1 ĐT01 Nguyễn Văn A 75.6 0.6

2 TS02 Nguyễn Thị B 75.6 0.5

3 QLHC08 Lê Văn C 75.6 0.8

4 TS03 Nguyễn Minh D 75.6 0.8

5 TS07 Hoàng Mạnh E 75.6 0.6

6 QLHC04 Lê Văn F 75.6 0.4

7 ĐT05 Nguyễn Văn G 75.6 0.7

8 QLHC01 Võ Văn H 75.6 0.4

9 ĐT02 Nguyễn Văn I 75.6 0.6

10 ĐT09 Nguyễn Văn J 75.6 0.5

BẢNG TIỀN LƯƠNG CỦA CBCS THÁNG 10/2023
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Đề bài: 

1: Điền cột Chuyên ngành dựa vào bảng dò. 

2: Tính cột Phụ cấp=Lương cơ bản*Hệ số (chỉ lấy phần nguyên). 

3: Tình cột Tiền thưởng dựa vào mã ngành và bảng lấy tiền thưởng (có sử 

dụng hàm MOD). 

4: Tính cột Tổng tiền=Phụ cấp+Tiền thưởng. 

5: Tạo thêm cột "Thứ hạng" sau cột Tổng, tính thứ hạng các đồng chí theo 

giá trị Tổng tiền giảm dần. 

6: Rút trích các đồng chí chuyên ngành điều tra, Tổng tiền từ 50$ trở lên. 

7: Hoàn thành Bảng thống kê 

 
8: Tô màu nguyên dòng với học viên học ngành Quản lý hành chính. 

9: Dùng Data Validation để cho phép các ô mã ngành chỉ tối đa 06 ky tự 

và kết thúc bằng 1 con số. 

BÀI 7: 

 

Mã ngành ĐT TS QLHC

Số lượng đồng chí

Tổng tiền

Bảng thống kê

STT Mã tội Tên tội phạm Tội danh Hình phạt Ngày bắt Nơi bắt Truy nã

1 TCTSA0 Nguyễn Văn A 1000000 TP. Hồ Chí Minh

2 GNC0 Nguyễn Văn B 7 năm tù Đà Nẵng 

3 BBMTB0 Huỳnh Văn C 5000000 Cần Thơ

4 BBMTB1 Nguyễn Thị D 5000000 Bến Tre

5 GNC1 Võ Văn E 7 năm tù Hà Nội

6 CGTSD0 Trần Văn H 1 năm tù Đà Nẵng 

7 TCTSA1 Phan Thị M 1500000 Cần Thơ

8 GNC2 Trần A 7 năm tù Tiền Giang

9 GNC3 Phạm Văn Q 7 năm tù TP. Hồ Chí Minh

10 BBMTB2 Hồ Xuân A 5000000 Hà Nội

11 TCTSA2 Nguyễn B 2000000 Hà Nội

12 CGTSD1 Lê Thị B 1 năm tù Đà Nẵng 

13 CGTSD2 Lê Văn C 1 năm tù Cần Thơ

BẢNG THỐNG KÊ TỘI PHẠM NĂM 2023

Bảng dò

Mã ngành ĐT TS QLHC

Chuyên ngành Điều tra Trình sát Quản lý hành chính

Bảng lấy tiền thưởng

Hệ số 01,03,05 02,04,06 07,09 08,10

ĐT 6 6 6 7

TS 5 7 4 7

QLHC 5 6 7 6

Le Hoai Duong
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           Câu hỏi 

1. Lập công thức cho điền dữ liệu cột Tội danh.  

2. Lập công thức cho cột Ngày bắt.  

3. Tính tổng số tiền phạt của tội danh trộm cắp tài sản với hình phạt hơn 

1000000 VND. 

4. Đếm số tội phạm có tội danh bị phạt tù.  

5. Sắp xếp các tội phạm theo sự tăng dần của ngày bắt.  

6. Dùng hàm mod để biết đối tượng bị bắt ở quý nào.  

7. Lập công thức cột Truy nã, biết tội phạm bị truy nã bị bắt ở Hà Nội.  

8. Trích xuất ra các tội phạm buôn bán ma tuý.  

9. Số tuần diễn ra hoạt động điều tra bắt tội phạm. 

 10. Tô màu nguyên dòng với các tên tội phạm bị bắt ở Đà Nẵng 

 11. Dùng Data Validation nhập mã tội danh kết thúc bằng 1 ky tự số. 

 BÀI 8: 

 

 

Tên tội phạm Ngày bắt 

Nguyễn Văn A 01/05/2023

Nguyễn Văn B 26/07/2023

Huỳnh Văn C 28/02/2023

Nguyễn Thị D 01/06/2023

Võ Văn E 01/05/2023

Trần Văn H 12/03/2023

Phan Thị M 15/02/2023

Trần A 01/05/2023

Phạm Văn Q 15/02/2023

Hồ Xuân A 11/07/2023

Nguyễn B 31/01/2023

Lê Thị B 18/05/2023

Lê Văn C 14/02/2023

STT Mã Tên Số vụ Mức độ tháng 1

1 01MT 12

2 02KT 10

01MTR 17

01TC 35

03KT 5

04MT 2

02TC 24

02MTR 7

Bảng thống kê tình hình tội phạm tháng 2

Mã tội Tội danh

CGTS Cướp giặt tài sản

TCTS Trộm cắp tài sản

GN Giết người 

BBMT Buôn bán ma tuý
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Yêu cầu:  

1. Điền STT trong bảng theo dạng 01, 02, 03…. 

2. Điền tên các loại. 

3. Điền dữ liệu vào cột mức độ. 

4. Dựa vào bảng thống kê tháng 1, điền các dữ liệu 

5. Tổng số vụ có mức độ nghiêm trọng và từ 10 vụ trở lên: 

6. Số loại có mức độ "Nghiêm trọng" và có trên 10 vụ:  

7. Điền cột tình hình, nếu số vụ lớn hơn tháng 1 thì "Tăng", ít hơn thì "Giảm" 

8. Thêm 1 cột, xếp thứ hạng các loại có số vụ từ cao đến thấp 

9. Thêm 1 cột, phân loại tình hình (theo bội số của 10). Ví dụ: <20 vụ: 

Loại 1, 20-50 vụ: Loại 2, >50: Loại 3 

10. Trích các loại tội phạm có số vụ tăng so với tháng 1 

11. Tô màu nguyên dòng với tội phạm đặc biệt nghiêm trọng 

12. Dùng Data Validation kiểm soát dữ liệu số vụ phải là số nguyên. 

BÀI 9: 

Cho vùng dữ liệu sau: 

 
 

 

Kí hiệu Mức độ

1 Ít nghiêm trọng

2 Nghiêm trọng

3 Nghiêm trọng

4 Đặc biệt nghiêm trọng

Bảng số liệu tháng 1: 

01MT 01MTR 01TC 02KT 02TC 03KT 04MT

10 15 25 7 32 2 1
Tháng 1

STT Tên Trung đội Chức Vụ

Chuyên 

ngành Triết CN KHXH KTCT

Tư tưởng 

HCM

Lịch sử 

Đảng

Điểm 

cộng

Điểm

 TB

Xếp

 Loại

Thứ

 hạng

Bùi Đức Hào B3-CSĐT-D32S Học viên 7 8 9 4 5

Từ Đình Hoàng B1-TSCS-D32S Lớp phó 8 9 9 7 6

Trần Văn Kiên KTHS-D32S Học viên 6 7 9 8 8

Võ Quốc Hòa B1-CSĐT-D32S Lớp trưởng 9 5 7 8 6

Lê Tiến Hai B2-QLHC-D32S Học viên 8 6 7 9 9

Hoàng Văn Đức B1-TSCS-D32S Học viên 8 6 5 7 8

Lê Thế Bảo B3-CSĐT-D32S Lớp phó 5 4 7 8 9

Cao Trần Thế Anh B2-QLHC-D32S Lớp trưởng 6 6 7 3 9

Dương Quốc Đạt B1-TSCS-D32S Học viên 8 8 8 7 7

Nguyễn Trần Huy Hoàng KTHS-D32S Học viên 6 5 9 8 9

BẢNG THỐNG KÊ ĐIỂM CÁC MÔN LÍ LUẬN CHÍNH TRỊ CỦA MỘT SỐ HỌC VIÊN NĂM 2023

Chức vụ Lớp trưởng Lớp phó Học viên

Điểm cộng theo chức vụ 0,3 0,2 0

Điểm cộng theo chức vụ
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Câu hỏi: 

1. Điền số thứ tự dạng 01, 02,…Lập công thức cho cột tên chuyên ngành. 

2. Hoàn thành cột điểm cộng 

3. Hoàn thành cột điểm trung bình, xếp loại học viên, biết điểm <5 là yếu, 

5<điểm<7 là tb,7< điểm<8 là khá,>8 lả giỏi 

4. Xếp thứ hạng của các học viên 

5. Cho lập ra hai cột phụ, hoàn thành bảng thông tin 

6. Lọc ra các học viên thuộc chuyên ngành Điều Tra Hình Sự có điểm 

Triết lớn hơn 5 

7. Hoàn thành bảng số liệu 

 
 8. Tô màu nguyên dòng học viên có điểm trung bình cao nhất 

 9. Chèn biểu đồ điểm TB theo các môn học vào trong sheet mới, đặt tên 

sheet là: Biểu đồ minh họa. 

BÀI 10: 

 
 

   

Mã ngành Chuyên ngành

CSĐT Cảnh sát điều tra

TSCS Trinh sát cảnh sát

QLHC Quản lí hành chính

KTHS Kĩ thuật hình sự

Mã ngành và chuyên ngành

Bảng thống kê

Số học sinh rớt môn Tư tưởng HCM

Số học sinh có điểm Triết là điểm chẵn

Số học sinh có điểm TB đầu 5

Tổng điểm môn Triết của sinh viên thuộc chuyên ngành Cảnh sát điều tra

STT Mã xe Loại xe Họ và tên Ngày bắt đầu Ngày kết thúc Số ngày gửi % giảm giá Thành tiền

1 A01L Võ Quốc H 01/10/2023 22/10/2023

2 A03VX Huỳnh Khánh D 01/10/2023 15/10/2023

B01TCV Lê Tiến H 03/10/2023 25/10/2023

B02L Phạm Nguyễn Nhựt H 02/10/2023 11/10/2023

C03TCV Bùi Đức H 04/10/2023 10/10/2023

C04VX Võ Thanh H 05/10/2023 29/10/2023

B03VX Hoàng Văn Đ 01/10/2023 12/10/2023

B01TCV Lê Văn Huỳnh Đ 03/10/2023 30/10/2023

A01L Lê Quang Đ 04/10/2023 11/10/2023

C01VX Nguyễn Đức D 02/10/2023 18/10/2023

BẢNG THỐNG KÊ TIỀN GỬI XE CỦA CÁN BỘ, HỌC VIÊN TRƯỜNG ĐHCSND TRONG THÁNG 10

Ký hiệu xe Loại xe Giảm giá

A Xe giảng viên 3%

B Xe cán bộ 2%

C Xe học viên 5%
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Câu hỏi: 

1: Ghi STT theo dạng 01, 02,… 

2: Điền cột loại xe  

3 : Điền cột % giảm giá 

4: Tính số ngày gửi = ngày kết thúc - ngày đầu 

5: Thành tiền tính như sau·: Tuần : 30000; Ngày : 5000 

6: Thêm cột thứ hạng bên trái cột Thành tiền 

7:Tính tổng tiền gửi xe điện của học viên 

8: Đếm số giảng viên gửi xe trên 20 ngày 

9: Lọc những người có tiền gửi xe trong tháng trên 50000 

 10: Tô màu nguyên dòng với người có số ngày gửi nhiều nhất 

 11: Dùng Data Validation để nhập liệu với quy tắc ngày kết thúc phải  sau 

ngày bắt đầu. 

BÀI 11: 

 

 

 

 

Phân loại xe L VX TCV

Kiểu xe Xe máy Xe điện Xe ô tô

BẢNG THỐNG KÊ TIÊU THỤ SẢN PHẨM THỜI GIAN VẬN CHUYỂN

STT Mã sản phẩm Đại lý Tên hàng - Tên hãng sản xuất Số lượng Đơn giá Thành tiền

8 CDR-SS SGN 96

2 KEY-DE HNN 35

3 MOU-IM DNA 19

4 KEY-SS HNN 39

5 CDR-DE SGN 20

6 KEY-SS HNN 35

7 KEY-DE DNA 17

8 MOU-IM HNN 22

9 CDR-DE DNA 53

10 MOU-IM SGN 88

TỔNG CỘNG

THỜI GIAN VẬN CHUYỂN

STT MÃ ĐƠN HÀNG NGÀY GIAONGÀY NHẬN SỐ NGÀY SỐ TUẦN

1 22/03/2022 11/05/2022

2 05/01/2022 20/01/2022

3 06/11/2022 15/11/2022

4 18/04/2022 15/05/2022

5 30/08/2022 01/10/2022

6 03/09/2022 28/09/2022

7 20/11/2022 02/12/2022

8 10/10/2022 29/10/2022

9 27/08/2022 30/09/2022

10 23/02/2022 01/04/2022
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Câu hỏi 

1. Căn cứ vào 3 ký tự bên trái và 2 ký tự bên phải của Mã SP trong Bảng 

1, hãy tra trong Bảng 2 để điền giá trị cho cột Tên Hàng - Tên Hãng Sản Xuất. 

Ví dụ : Mã SP là CDR-SS thì có Tên Hàng - Tên Hãng Sản Xuất là : 

CDRom - Sam Sung 

2. Hãy điền Đơn Giá cho mặt hàng dựa vào thông tin ở Bảng 1 và Bảng 2. 

3. Tính Thành Tiền = Số Lượng * Đơn Giá, nếu Số lượng >=50 thì thành 

tiền được giảm 5%  

4. Thêm cột Thứ hạng bên cạnh cột thành tiền 

5. Lọc ra những thông tin có liên quan Đại lý DNA 

6. Thêm cột Mã hàng bên cạnh cột Thứ hạng, nếu số kí tự của Tên hàng - 

Tên hãng sản xuất nhỏ hơn 15 thì trả về "Mã 1", còn lại "Mã 2" 

7. Điền vào bảng THỜI GIAN VẬN CHUYỂN:  

 Điền vào ô Mã hàng = Mã sản phẩm - Số lượng - Đại lý 

 Tính số ngày vận chuyển và điền vào ô SỐ NGÀY 

 Điền vào ô SỐ TUẦN, VD: 3 tuần 2 ngày 

8. Tô màu nguyên dòng đơn hàng có số tuần gửi lớn hơn 2 

9. Dùng Data Validation kiểm soát ngày nhận phải trong năm 2022. 

 

Mã hàng - Tên hãng sản xuất

SS IM DE

Mã hàng Tên hàng Samsung IBM Dell

CDR CDRom 30 25 20

KEY Keyboard 10 17 15

MOU Mouse 5 9 13

Tỷ giá 23.800 VNĐ

THỐNG KÊ

Kết quả

Tổng số tiền Keyboard của Đại lý HNN

Tổng loại sản phẩm của hãng Dell đại lý DNA
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BÀI 12: 

 

 

 

 Câu hỏi: 

1: Dựa vào kí tự đầu tiên của mã xe kết hợp với bảng 1 để tìm ra loại xe. 

2: Dựa vào loại xe kết hợp với bảng 2 tìm ra giá.  

3: Dựa vào 2 kí tự cuối cùng của mã xe để tìm ra số ngày gửi 

4: Số tuần=Số ngày gửi/7 

5: Số ngày dư số dư của số ngày gửi/7 

6: Tìm % giảm giá (nếu số tuần >2 thì giảm 5%,>1 thì giảm 3%) 

7: Thành tiền=Giá*Số ngày gửi-%Giảm giá*Giá*Số Ngày gửi 

8: Sắp xếp thứ hạng của thành tiền (Theo thứ tự giảm dần) 

9: Lập bảng thống kê số lượng của từng loại xe 

10: Tính tổng thành tiền từng loại xe 

11: Lọc nâng cao theo loại xe SH 

12: Tô màu nguyên dòng với học viên đi SH. 

13: Dùng Data Validation để nhập mã xe có cấu trúc: Có đúng 03 k tự, kết 

thúc bằng 1 kys tự số.  

 

STT Họ và tên Mã xe Loại xe Giá Số ngày gửi Số tuần Số ngày dư % Giảm giá Thành tiền Thứ hạng

1 Huỳnh Thanh Phong V21

2 Đặng Đình Tân W16

3 Lê Ngọc Sang S14

4 Trần Thanh Nhàn S17

5 Nguyễn Văn Phú V09

6 Trần Ngọc Phát A25

7 Phạm Trọng Tài W27

8 Vũ Nhật Nam A12

9 Phan Như Khoa W07

10 Nguyễn Việt Quang A10

BẢNG THỐNG KÊ TIỀN GỬI XE CỦA HỌC VIÊN TRƯỜNG ĐHCSND THÁNG 11

A AIRBLADE

V VISION

S SH

W WAVE

Bảng 1: Loại xe

AIRBLADE VISION SH WAVE

8000 7500 9500 6000
Giá gửi

Bảng 2: Giá gửi xe
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BÀI 13: 

 

       

 

 

 

Câu hỏi: 

1. Cột điểm cộng: nếu là TĐT, TĐP cộng 0,2 , nếu là HV cộng 0 (sử dụng 

hàm VLOOKUP) 

2. Cột HV năm ghi theo từng khóa, VD:30S là HV năm 4....(sử dụng hàm 

if, right) 

3. Tính cột điểm trung bình dùng hàm average. 

4. Điền cột kết quả biết nếu điểm thể chất lớn hơn 8 và điểm trung bình 

lớn hơn 7 thì đạt còn lại rớt. ( sử dụng hàm IF, AND ) 

5. Điền cột khoa dựa theo tên lớp, VD: B3-CSĐT-D32S ở khoa 

CSĐT…..( sử dụng hàm LEN, RIGHT, LEFT) 

6. Tính thứ hạng dụa theo cột điểm trung bình. (sử dụng hàm RANK) 

7. Lọc ra các lớp có học viên tham gia tuyển chọn. (Advanced Filter) 

8. Tính cột điểm tổng cộng các khoa. (sử dụng hàm SUMIFS) 

9. Tô màu nguyên dòng học viên có điểm TB thấp nhất 

10. Dùng Data Validation kiểm soát điểm Tin học nhỏ hơn hoặc bằng 10 

11. Xây dựng biểu đồ dạng cột điểm trung bình theo các môn học. 

 

Tin học AV1 AV2
Thể chất

1 Nguyễn Văn Linh TĐT B3-CSĐT-D30S 4 7 9 7

2 Đinh Văn Tuấn HV B3-TSCS-D31S 9 8 6 6

3 Võ Tuấn Minh HV B3-CSĐT-D32S 10 6 8 8

4 Lê Xuân Toán HV B3-QLHC-D30S 8 10 3 9

5 Đinh La Dĩnh TĐP B3-KTHS-D32S 7 6 5 9

6 Lê Minh TĐP B3-KTHS-D33S 6 5 9 8

7 Trần Văn Sang HV B3-TSCS-D31S 9 7 5 5

8 Nguyễn Thị Ngọc Kiều HV B3-CSĐT-D30S 4 9 10 6

9 Lê Văn Thành Công TĐT B3-TSCS-D32S 5 10 6 10

10 Trần Thị Ngọc Linh HV B3-CSĐT-D32S 9 8 10 5

HV 

năm

Điểm 

TB

Kết 

quả
Khoa

Thứ

hạng
STT Họ và tên 

Chức 

vụ
Lớp

Điểm 

cộng

Môn

TĐT 0,2

TĐP 0,2

HV 0

Các lớp tham gia tuyển 

chọn

Khoa CSĐT TSCS QLHC KTHS

Tổng điểm
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BÀI 14: 

 

 

 

 

Câu hỏi: 

1. Căn cứ vào 3 ký tự bên trái và 2 ký tự bên phải của Mã SP trong Bảng 

1, hãy tra trong Bảng 2 để điền giá trị cho cột Tên Hàng - Tên Hãng Sản Xuất. 

Ví dụ : Mã SP là CDR-SS thì có Tên Hàng - Tên Hãng Sản Xuất là: CDRom - 

Sam Sung  

2. Hãy điền Đơn Giá cho mặt hàng dựa vào thông tin ở Bảng 1 Bảng 2. 

BẢNG THỐNG KÊ TIÊU THỤ SẢN PHẨM THỜI GIAN VẬN CHUYỂN

STTMã sản phẩm Đại lý Tên hàng - Tên hãng sản xuấtSố lượng Đơn giá Thành tiền

8 CDR-SS SGN 96

2 KEY-DE HNN 35

3 MOU-IM DNA 19

4 KEY-SS HNN 39

5 CDR-DE SGN 20

6 KEY-SS HNN 35

7 KEY-DE DNA 17

8 MOU-IM HNN 22

9 CDR-DE DNA 53

10 MOU-IM SGN 88

THỜI GIAN VẬN CHUYỂN

STT MÃ ĐƠN HÀNG NGÀY GIAO NGÀY NHẬN SỐ NGÀY SỐ TUẦN

1 22/03/2022 11/05/2022

2 05/01/2022 20/01/2022

3 06/11/2022 15/11/2022

4 18/04/2022 15/05/2022

5 30/08/2022 01/10/2022

6 03/09/2022 28/09/2022

7 20/11/2022 02/12/2022

8 10/10/2022 29/10/2022

9 27/08/2022 30/09/2022

10 23/02/2022 01/04/2022

BẢNG TRA TÊN HÀNG, TÊN HÃNG SẢN XUẤT VÀ ĐƠN GIÁ

Mã hàng - Tên hãng sản xuất

SS IM DE

Mã hàng Tên hàng Samsung IBM Dell

CDR CDRom 30 25 20

KEY Keyboard 10 17 15

MOU Mouse 5 9 13

Tỷ giá 23,800 VNĐ

Kết quả

Tổng số tiền Keyboard của Đại lý HNN

Tổng loại sản phẩm của hãng Dell đại lý DNA

THỐNG KÊ
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3. Tính Thành Tiền = Số Lượng * Đơn Giá, nếu Số lượng >=50 thì thành 

tiền được giảm 5%. 

4. Thêm cột Thứ hạng bên cạnh cột thành tiền. 

5. Lọc ra những thông tin có liên quan Đại lý DNA, 

6. Thêm cột Mã hàng bên cạnh cột Thứ hạng, nếu số kí tự của Tên hàng - 

Tên hãng sản xuất nhỏ hơn 15 thì trả về "Mã 1", còn lại "Mã 2". 

7. Điền vào bảng THỜI GIAN VẬN CHUYỂN: Điền vào ô Mã hàng = 

Mã sản phẩm - Số lượng - Đại lý. Tính số ngày vận chuyển và điền vào ô SỐ 

NGÀY. Điền vào ô SỐ TUẦN, VD: 3 tuần 2 ngày. 

8. Tô màu nguyên dòng tất cả các mã hàng CDROM bán ở HN hoặc SG. 

9. Dùng Data Validation kiểm soát ngày nhận cùng hoặc sau ngày giao. 

BÀI 15: 

 

 

 

 

 

 

Câu hỏi 

1. Biết thâm niên từ 15 năm sẽ được công nhận là gắn bó, nếu số thâm 

niên dư ra 1 năm là cực yêu ngành và dư trên 1 năm là rất yêu ngành, cho phép 

thêm cột phụ để xác định. 

STT Họ và tên Mã số

Cấp bậc 

hàm Chức vụ

Thời gian 

vào ngành

Thâm 

niên

Hệ số 

lương

Phụ cấp 

đặc biệt

Tiền 

lương

Nguyễn Văn Phú 01-Thg.Tá 15/05/2004

Nguyễn Thanh Minh 01-Tr.Tá 15/05/2010

Phạm Trọng Tài 04-Th.Úy 15/05/2021

Nguyễn Việt Quang 03-Tr.Úy 15/05/2018

Huỳnh Thanh Phong 01-Đ.Úy 15/05/2011

Trần Thanh Nhàn 02-Đ.Úy 15/05/2011

Vũ Nhật Nam 01-Tr.Úy 15/05/2018

Trần Ngọc Phát 02-Thg.Tá 15/05/2004

Lê Ngọc Sang 02-Th.Tá 15/05/2010

Đặng Đình Tân 01-Đ.Úy 15/05/2011

Kết quả Thống kê

Số người có cấp bậc Đại Úy

Số người có cấp bậc Thượng tá và lương trên 10tr

Tính tổng tiền lương của những người trên 10tr

Tính tổng tiền lương cấp bậc Đại Úy và lương trên 10tr

Cấp bậc hàm Thượng Tá Trung Tá Thiếu Tá Đại Úy Trung Úy Thiếu Úy

Hệ số 7,3 6,6 6 5,4 4,6 4,2

Chức vụ Trưởng phòng Phó phòng Phó phòng Đại đội trưởng Phó đại đội trưởng Tiểu đội trưởng

Kí hiệu Thg.Tá Tr.Tá Th.Tá Đ.Úy Tr.Úy Th.Úy

Cấp bậc hàm Thượng Tá Trung Tá Thiếu Tá Đại Úy Trung Úy Thiếu Úy

Mã số Hệ số Phụ cấp đặc biệt

01 0,8

02 0,7

03 0,6

04 0,5
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2. Điền số thứ tự vào cột STT với dạng 001,002,003 

3. Hoàn thành cột cấp bậc hàm, chức vụ, phụ cấp đặc biệt dựa vào bảng 

dò có sẵn 

4. Hoàn thành cột Tiền lương biết Tiền lương= tổng hệ số lương(cơ bản 

và phụ cấp)*Lương cơ bản(1800000) và định dạng VNĐ 

5. Hoàn thành cột Thâm niên 

6. Hoàn thành bảng thống kê 

7. Thêm cột Thứ hạng bên phải cột Tiền lương và sắp xếp theo thứ hạng 

tiền lương từ thấp đến cao 

8. Lọc ra những người có thâm niên lớn hơn 10 năm 

9. Tô màu nguyên dòng những đồng chí giữu chức Trưởng phòng 

10. Dùng Data Validation kiểm soát thời gian vào ngành trước năm 2024 

BÀI 16: 

 

 

 

 Câu hỏi: 

1. Tìm hệ số lương (VLOOKUP)  các cấp bậc thông qua bảng dò 1. 

2. Tìm phụ cấp thêm biên giới (HLOOKUP) qua bảng dò 2. 

3. Tình mức lương nhận được của CBCS bằng cthuc =  hệ số lương* 

lương cơ bản + phụ cấp thêm*Lương cơ bản. 

4. Xếp hạng mức lương( RANK) nhận được theo từ lớn đến bé 

5. Dựa vào 2 số sau dấu gạch ngang (MID & LEN ) để xác định giới tính 

nếu "01" là Nam, "02" là Nữ. 

6. Tìm ra (COUNTIFS ) số người nhận được mức lương > 1000000 có họ 

bắt đầu bằng chữ "N". 

STT Họ tên Mã ngành Năm sinh Đơn vị công tác Cấp bậc
Giới 

tính

Hệ số 

lương

Phụ cấp 

thêm 

Tổng 

lương

Thứ 

hạng

Chức 

vụ

01 Vũ Nhật Nam CA-01-453 21/09/1983 CAT Cao Bằng Trung tá

02 Nguyễn Thanh Thu CA-02-345 14/11/1993 CAT Đăk lăk Thượng úy

03 Nguyễn Văn Phú CA-01-349 03/02/1989 CAT Quảng Ngãi Trung tá

04 Trần Ngọc Như CA-02-456 21/02/1990 CAT Cà Mau Thiếu tá

05 Lê Ngọc Sang CA-01-401 15/08/1994 CAT Gia Lai Trung úy

06 Đặng Đình Tân CA-01-789 20/08/1983 CAT Hà Tĩnh Thượng tá

07 Phạm Trọng Tài CA-01-459 17/06/1992 CAT Đăk lăk Thượng úy

BẢNG LƯƠNG CBCS CÔNG AN NHÂN DÂN

Bảng dữ liệu 1

Cấp bậc Hệ số lương

Thượng tá 7,3

Trung tá 6,6

Thiếu tá 6

Thượng úy 5

Trung úy 4,6

Bảng 2

Đơn vị CAT Cao bằng CAT Đăk Lăk CAT Hà Tĩnh CAT Quảng Ngãi CAT Cà Mau CAT Gia Lai

Phụ cấp thêm 50% 40% 10% 0% 20% 40%
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7. Tính tổng tiền lương (SUMIFS) phải trả cho những người lãnh đạo sinh 

trong năm 1983. 

8. Nếu cấp bậc có chữ "tá"(IF & RIGHT) thì là lãnh đạo, ngược lại là cán 

bộ thường 

9. Tính số tuổi và ngày lẻ của CBCS có ở trên (INT & MOD) 

10. Lọc ra những cán bộ có mức lương >1000000 

 11. Tô màu nguyên dòng với CBCS là nữ. 

 12. Dùng Data Validation để nhập năm sinh phải lớn hơn năm 1960. 

BÀI 17: 

 

 

 

 

 

Câu hỏi: 

1. Tính các bảng thống kê. 

2. Tính thứ hạng các tỉ lệ. Chỉnh tiền thành vnđ và có dấu phẩy ngăn cách. 

3. Tra bảng để điền tội danh theo mã và in hoa mỗi chữ cái đầu. 

4. Tra bảng để điền mức độ và in hoa các chữ cái. 

STT HỌ VÀ TÊN GIỚI TÍNH NĂM SINH MÃ PHẠM TỘI TỘI DANH MỨC ĐỘ

Nguyễn Sinh Nam 2004 ĐB1

Nguyễn Văn Nam Nam 1995 I3 CỐ Ý GÂY THƯƠNG TÍCH

Phạm Cao Kiên Nam 2002 ĐB1

Ngô Anh Vũ Nam 2006 R2

Lê Thanh Hoài Nữ 2007 R2

Trần Thị Hoa Nữ 2008 I3

Đỗ Vân Nga Nữ 2005 I3

Cao Hoàng Nam Nam 2005 R2

Nguyễn Tấn Tài Nam 2007 ĐB1

Trần Văn Hùng Nam 1955 N4

Đỗ Văn Nam Nam 1990 N4

Cao Trung Phát Nam 2008 I3

THỐNG KÊ TỘI PHẠM TRONG HUYỆN X

GIẾT NGƯỜI

CỐ Ý GÂY THƯƠNG TÍCH

ĐÁNH BẠC

CƯỚP GIẬT TÀI SẢN

TỈ LỆ %

MÃ PHẠM TỘI TỘI DANH

1 Giết người

2 Cố ý gây thương tích

3 Đánh bạc, tổ chức đánh bạc

4 Cướp giật tài sản

TÊN TỘI DANH

MÃ PHẠM TỘI ĐB R I N

MỨC ĐỘ NGUY HIỂM Đặc biệt nghiệm trọng Rất nghiêm trọng Ít nghiêm trọng Nghiêm trọng

MỨC ĐỘ CÁC TỘI DANH

ĐỐI TƯỢNG Nguyễn Văn Nam Trần Thị Hoa Đỗ Vân Nga Cao Trung Phát

TIỀN THU ĐƯỢC 50.000.000,00                     100.000.000,00    49.220.200,00               18.865.245,00   

SỐ TIỀN THU GIỮ TRONG CÁC VỤ ĐÁNH BẠC
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5. Lọc các đối tượng là trẻ chưa thành niên vi phạm. 

6. Tính số tội phạm giết người sinh sau năm 2004. 

7. Tính số người trung bình phạm tội đặc biệt và rất nghiêm trọng. 

8. tổng số tiền thu được từ các vụ đánh bạc trên 45000000 và đối tượng vi 

phạm có chữ "n" trong tên. 

 9. Tô màu nguyên dòng với các tên tội phạm sinh năm 2000 trở về trước 

 10. Dùng Data Validation kiểm soát năm sinh trước 2010 

BÀI 18: 

 

 

 

Câu hỏi: 

1. Đánh số thứ tự cho bảng (ở dạng 01,02,..). 

2. Căn cứ vào 2 kí tự bên trái, 2 kí tự bên phải bảng 2 để điền tên TH vi 

phạm. Vd: M1OT: Mức 1 Ô tô. 

3. Lập công thức Hình phạt bổ sung. 

4. Lập công thức tính mức phạt. 

5. Tính tổng thu XLVP = Mức phạt*Số trường hợp. 

6. Định dạng dấu phẩy ngăn cách hàng triệu, hàng nghìn, hằng trăm. Đơn 

vị VND. 

Stt Mã vi phạm Địa điểm

Tên trường hợp 

vi phạm Thời gian vi phạm Mức phạt Số trường hợp

Tổng thu xử lí vi 

phạm

01 M1OT Bình Tân 18/10/2023 23

02 M2XM Gò Vấp 17/10/2023 17

M1XĐ Tân Phú 03/10/2023 52

M3XM Bình Thạnh 09/01/2023 9

M2OT Phú Nhuận 16/10/2023 49

M2XĐ Tân Bình 27/10/2023 51

M3OT Gò Vấp 19/10/2023 19

M1OT Phú Nhuận 20/10/2023 25

M2XĐ Bình Thạnh 05/10/2023 16

M1OT Bình Tân 18/10/2023 22

M2OT Gò Vấp 21/10/2023 35

M3XM Gò Vấp 28/10/2023 18

M1XĐ Tân Phú 05/10/2023 45

M2XM Bình Thạnh 19/10/2023 55

M1XM Phú Nhuận 24/10/2023 20

BẢNG THỐNG KÊ SỬ LÍ VI PHẠM NỒNG ĐỘ CỒN

Bảng tra tên vi phạm - mức phạt

Mã phương tiện Tên phương tiện Mức 1 Mức 2 Mức 3

OT Ô tô 7.500.000        17.000.000           35.000.000  

XM Xe máy 2.500.000        4.500.000             7.000.000    

XĐ Xe đạp 90.000             350.000                500.000       

Mức phạt

Mức 1 Mức 2 Mức 3

Ô tô, Xe máy 10 - 12 tháng 16 - 18 tháng 22 - 24 tháng

Phạt bổ sung (tước giấy phép)
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7. Thêm cột "Thứ hạng" bên phải cột Tổng thu XLVP, tính thứ hạng tổng 

thu theo giá trị giảm dần. 

8. Tính tổng trường hợp vi phạm của Xe máy ở Gò vấp. 

9. Số loại vi phạm có số TH cao hơn 20 TH ở Bình Tân. 

10. Ứng dụng hàm mod để tô màu đỏ cột địa điểm (cách 1 ô tô một ô). 

11. Lọc ra những vi phạm ở mức 1 của ô tô. 

12. Tô màu nguyên dòng với địa điểm có tổng thu lớn nhất. 

13. Dùng Data Validation kiểm soát thời gian vi phạm trước 01/01/2024. 

BÀI 19: 

 
 

STT HỌ VÀ TÊN
NĂM 

SINH
SỐ HỒ SƠ

PHÂN 

LOẠI

HỆ 

LOẠI

DANH 

MỤC

CÁN BỘ 

PHỤ TRÁCH

THEO 

QUÝ

1 Phan Thị N 2003 370122/05B1//010101SN

2 Nguyễn Bảo C 1999 4970522/02A2//010101SN

3 Nguyễn Ngọc Kiều D 2004 8881222/03B3//010101SN

4 Phạm Thị Thảo H 2005 10451023/04C3//010101SN

5 Trần Anh T 1998 11560423/01A4//010101SN

6 Trần Thùy T 2002 22310723/03B2//010101SN

7 Võ Văn N 1998 2970219/02B1//010101SN

8 Trần Công N 2000 10370618/04B1//010101SN

9 Dương Văn T 1990 250322/01C4//010101SN

10 Huỳnh U 2006 380921/02B3//010101SN

11 K'sor B 1989 4970522/02A2//010101SN

12 Nguyễn Tuấn A 2001 8880322/03B3//010101SN

13 Trương Thành N 2007 10451023/04C3//010101SN

14 Huỳnh Thanh H 1988 11560423/01A4//010101SN

15 Lưu Quang V 1987 21310723/03B2//010101SN

16 Nguyễn Quốc T 1995 9970219/02B1//010101SN

17 Phạm Văn T 1987 170918/04B1//010101SN

18 Lê Đình H 2005 2500322/01C4//010101SN

19 Nguyễn Hùng M 2005 2520322/01C4//010101SN

20 Trần Đức L 1980 11370620/04B1//010101SN

21 Bùi Đức L 1995 260522/01C4//010101SN

22 Bùi Khắc H 1993 380821/02B3//010101SN

23 Bùi Hoàng Thùy T 1997 4970522/02A2//010101SN

24 Bùi Khắc Nhân H 1998 8880322/03B3//010101SN

25 Tạ Văn D 2005 10451023/04C3//010101SN

ĐỐI TƯỢNG QUẢN LÝ NGHIỆP VỤ SƯU TRA MA TÚY
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 Đề bài: Số hồ sơ có dạng "số hồ sơ, tháng năm lập (mmyy)/phân loại, 

hệ mục, danh loại//010101SN" 

 1. Nhập dữ liệu như bảng tính. 

2. Điền vào ô phân loại theo Bảng đối chiếu. 

3. Điền vào ô hệ loại theo Bảng đối chiếu. 

4. Điền vào ô danh mục theo Bảng đối chiếu. 

5. Điền vào ô cán bộ phụ trách theo tháng lập hồ sơ. 

6. Dùng hàm INT và MOD để hoàn thành bảng chia Theo Quý. 

7. Thống kê các nội dung trong Bảng thống kê. 

A

B

C

01

02

03

04

05

1

2

3

4

Phân 

loại

Hệ

loại

Danh

mục

II  - Đã có tiền sự

III - Chưa có tiền án tiền sự

IV - Người nước ngoài đang định cư

Vận chuyển và mua bán trái phép chất ma túy

Tổ chức sử dụng hoặc chứa chấp sử dụng trái phép chất ma túy

Sản xuất công cụ, phương tiện phục vụ việc sử dụng và điều chế chất ma túy

Làm sai trái các hoạt động hợp pháp về ma túy

I - Đã có tiền án

BẢNG ĐỐI CHIẾU

Có điều kiện, khả năng hoạt động phạm tội

Có biểu hiện nghi vấn hoạt động phạm tội

Có dấu hiệu phạm tội cụ thể

Sản xuất trái phép chất ma túy

Số đối tượng Sưu tra B

Số đối tượng chưa có tiền án, tiền sự

Số đối tượng (hồ sơ) trên 18 tuổi

Số đối tượng (hồ sơ) dưới 18 tuổi

Số đối tượng Sưu tra A

BẢNG THỐNG KÊ 01

X.HẠNG

Ánh Linh

Kim Yến

Thanh Phương

Phương Dung

Thế Anh

Đông Uyên

Thúy Hồng

Ngọc Uyên

Quốc Thuận

Huyền Huy

SỐ HS PHỤ TRÁCH

Hồng Phúc

Anh Thụy

BẢNG THỐNG KÊ 02

Tháng 01 02 03 04 05 06 07 08 09 10 11 12

Cán 

bộ

Hồng 

Phúc

Anh 

Thụy

Ngọc 

Uyên

Quốc 

Thuận

Huyền 

Huy

Thanh 

Phương

Phương 

Dung

Thế 

Anh

Đông 

Uyên

Thúy 

Hồng

Ánh 

Linh

Kim 

Yến

BẢNG PHÂN CÔNG
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8. Tổng hợp số hồ sơ phụ trách của mỗi cán bộ và xếp hạng theo Bảng 

thống kê 02. 

9. Lọc ra số hồ sơ chỉ có 2 số hồ sơ. Ví dụ: 260522/01C4//010101SN. 

10. Tô màu nguyên dòng với đối tượng thuộc Phân loại A. 

11. Dùng Data Validation kiểm soát năm sinh trước 2023. 

BÀI 20: 

 

 

 

 

 Câu hỏi: 

1. Dựa vào bảng MÃ TD và TỘI DANH lập công thức cột TỘI DANH. 

2. Lập công thức tìm mức độ,nếu 2 kí tự cuối của MÃ TD là"01" là "Ít 

nghiêm trọng","02" là "Nghiêm trọng","03" là "Rất nghiêm trọng" còn lại là 

"Đặc biệt nghiêm trọng 3. KÍ HIỆU TD nếu 2 kí tự cuối của MÃ TD là"01" là 

"INT","02" là "NT","03" là "RNT còn lại là "DBNT".    

 4. Dựa vào bảng thống kê 6 tháng đầu năm để điền vào cột số lượng.  

5. Dùng hàm countifs và sumifs để tính vào bảng thống kê phạm tội.  

6. Thêm một cột thứ hạng và xắp xếp thứ hạng số lượng từ cao đến thấp.

 7. Xắp xếp lại bảng theo thứ tự thứ hạng cao đến thấp.  

8. Lọc các tội danh có số lượng nhỏ hơn 100 hoặc lớn hơn 200  

9. Tô màu tội phạm Đặc biệt nghiêm trọng. 

10. Dùng Data Validation kiểm soát nhập liệu số lượng luôn dương 

STT MÃ TD TỘI DANH MỨC ĐỘ KÍ HIỆU MĐ SỐ LƯỢNG

1 TCTS01

2 DB01

3 CYGTT02

4 MT04

5 LD01

6 GN04

7 HD03

8 TN03

TÌNH  HÌNH TỘI PHẠM 6 THÁNG ĐẦU NĂM 2023

MÃ TD TỘI DANH

TCTS Trôm cắp tài sản

DB Đánh bạc

CYGTT Cố ý gây thương tích

MT Buôn bán ma tuý

LD Lừa đảo chiếm đoạt tài sản

GN Cố ý giết người 

HD Hiếp dâm

TN Tham nhũng

MÃ TD TCTS DB CYGTT MT LD GN HD TN

SỐ LƯỢNG 134 123 321 343 172 24 84 10

BẢNG THỐNG KÊ 6 THÁNG ĐẦU NĂM

THỐNG KÊ PHẠM TỘI

Tổng các tội danh có mức độ INT và có số lượng >100

Có bao nhiêu tội danh có mức độ INT và có số lượng dưới 150

Có bao nhiêu tội danh có mức độ DBNT và có số lượng trên150
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BÀI 21: 

 

    

 

Câu hỏi   

1. TÊN NGÀNH: căn cứ vào kí tự đầu của MÃ NGÀNH.   

2. ĐIỂM CỘNG: căn cứ vào CHỨC VỤ.   

3. TỔNG ĐIỂM: tiếng anh+logic học+tâm lý học+điểm cộng.   

4. KẾT QUẢ: tổng điểm từ 20 trở lên thì đậu, dưới 20 thì rớt.   

5. Lập danh sách học viên có chức vụ.   

6 .Thứ tự kết quả.    

7. Tổng điểm Tiếng Anh của các học viên họ Nguyễn.   

 8. Tô màu nguyên dòng với học viên học ngành Điều tra mà có tổng điểm 

lớn hơn 20. 

 9. Dùng Data Validation kiểm soát quá trình nhập liệu, mã ngành chỉ nhận 

các giá trị A, B và C 

II. CÂU HỎI TRẮC NGHIỆM 

Câu 1: Khi sử dụng Excel, dùng chức năng lưu tệp (File, Save As) và trong 

phần “File name” ta gõ vào chuỗi BAILAM thì tệp đó được lưu trong đĩa với tên 

thực tế là 

A. BAILAM.XLSX.  B. BAILAM.DOCX.   

C. BAILAM.TXT. D. BAILAM.   

STT HỌ VÀ TÊN CHỨC VỤ MÃ NGÀNH
TÊN 

NGÀNH
LOGIC HỌC

TIẾNG 

ANH

TÂM LÝ 

HỌC
ĐIỂM CỘNG

TỔNG 

ĐIỂM
KẾT QUẢ

1 Nguyễn Bảo Trinh Có A 8 7,5 7

2 Nguyễn Ngọc Kiều Diễm Không A 8 7 7

3 Nguyễn Thảo Huyền Có B 7,5 7,6 8

4 Phan Thị Nhung Không C 8,5 8 7

5 Phạm Thị Thuỳ Trang Không B 9 7,8 7,8

6 Dương Quốc Đạt Có A 6,5 6,7 6

7 Nguyễn Tạ Việt Anh Có C 7 6,5 5

8 Lê Thế Bảo Không A 7 5 6

Bảng kết quả

Mã ngành Tên ngành

A Điều tra

B Trinh sát

C Ma tuý

Ngành 

học

Chức vụ Điểm

Có 1

Không 0

Điểm cộng
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Câu 2: Trong Excel, khái niệm “workbook” thực chất là 

A. Tệp.                                      B. Gồm nhiều khối chứa số liệu giống nhau. 

D. Sheet hiện hành.                   C. Gồm nhiều Sheet có tên giống nhau..  

Câu 3: Trong Excel, khi mở menu File, chọn Close là ta muốn 

A. Đóng lại một Workbook. B. Thoát khỏi Excel.   

C. Cả hai câu (a), (b) đúng. D. Cả hai câu (a), (b) sai.  

Câu 4: Trong Excel, chức năng Freeze Panes dùng để 

A. Che dữ liệu (hide) một số hàng. B. Che dữ liệu (hide) một số cột. 

C. (A), (B) đúng. D. (A), (B) sai.  

Câu 5: Trong Excel, để canh trái dữ liệu trong một ô, sau khi chọn ô đó 

A. Ta click vào biểu tượng canh trái.                C. Cả hai câu (a),(b) sai. 

B. Ta nhấn tổ hợp phím Ctrl + L.                      D. Cả hai câu (a), (b) đúng. 

Câu 6: Trong Excel, khi mở menu File, chọn New ta sẽ có một tệp bảng 

tính mới với số lượng sheet là 

A. 3.                                   B. Không quá 5.   

C. 1.    D. Tùy thuộc vào cấu hình của Excel. 

Câu 7: Trong Excel, sheet chứa con trỏ khi vừa mở một tệp bảng tính được 

quyết định bởi 

A. Nó là sheet đầu tiên của tệp. B. Nó là sheet làm việc lúc tệp được lưu 

vào đĩa. 

C. Nó là sheet cuối của tệp.     D. Được qui định sẵn trong Microsoft Excel. 

Câu 8: Trong Microsoft Excel, ta có thể lưu một tệp với tên là 

A. sbd15.docx. B. sbd15.xlsx.   

C. (A), (B) sai. D. (A), (B) đúng.  

Câu 9:  Thanh công cụ nào sau đây chỉ có trong Excel mà không có 

trong Word 

A. Formulas. B. Standard. 
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C. Insert. D. Page Layout. 

Câu 10: Trong Excel, để kẻ khung cho một vùng bảng tính đã chọn, ta 

thực hiện 

A. Format cells\Border and Shading. B. Format cells\Border. 

C. Format cells\Sheet. D. Format cells\Style. 

Câu 11: Trong Excel, để nhập một công thức vào ô, ta thực hiện: 

A. Chỉ cần nhập đúng công thức vào ô. 

B. Nhập công thức vào ô sau đó gõ thêm phím F2. 

C. Nhập dấu = vào trước công thức đó. 

D. Nhấp đúp vào ô trước khi nhập công thức vào. 

Câu 12: Trong Excel, phím nào dưới đây có chức năng chuyển đổi giữa các 

dạng địa chỉ? 

A. F1                             B. F2.                       C. F3.                    D. F4. 

Câu 13: Trong Excel, dữ liệu kiểu số khi nhập vào ô ở dạng mặc định 

sẽ được 

A. Canh phải. B. Canh trái. 

C. Canh giữa. D. Canh đều. 

Câu 14: Trong Excel, để thực hiện tính tổng ta có thể dùng nút lệnh nào ? 

A. .                        B. .                            C. .                 D. . 

Câu 15: Trong Excel, chức năng của phím F2 là 

A. Chuyển sang chế độ hiệu chỉnh.                     B. Lưu tập tin. 

C. Chuyển đổi giữa các dạng địa chỉ.                 D. Thoát khỏi chương trình. 

Câu 16: Trong Excel, nút  dùng để 

A. Canh lề cho các ô sô.              B. Thay đổi kích cỡ chữ. 

C. Thay đổi độ rộng của ô.         D. Ghép nhiều ô thành một ô và canh giữa. 

Câu 17: Trong Excel, để nhập và hiển thị kiểu ngày như 26/09/2012, ta cần: 

A. Vào Control Panel thiết lập kiểu định dạng ngày dạng dd/mm/yyyy. 
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B. Vào Format\Cell thiết lập kiểu định dạng ngày dd/mm/yyyy. 

C. Phải thực hiện cả hai thao tác A và B. 

D. Tất cả đều sai. 

Câu 18: Trong Excel, để đổi tên Sheet 

A. Nhấp phải chuột vào tên sheet cần đổi tên, chọn Rename. 

B. Nhấp vào sheet cần đổi tên, vào File\Rename. 

C. Cả (A) và (B) đều đúng. 

D. Cả (A) và (B) đều sai. 

Câu 19: Trong Excel 2010, một Sheet có: 

A. 16.384 cột. B. 1.048.576 dòng. 

C. Tên cột cuối cùng là XFD. D. Cả (A), (B), (C) đúng. 

Câu 20: Trong Excel, đối với một Sheet, ta có thể thực hiện thao tác 

sau đây: 

A. Đổi tên Sheet.                                        B. Copy toàn bộ nội dung Sheet. 

C. Cả (A), (B) đều đúng.                            D. Cả (A), (B) đều sai. 

Cho bảng tính với các số liệu dưới đây, các câu hỏi sau đều lấy số liệu trên 

bảng này: (câu 21 – 37) 

 

Câu 21: Hãy cho biết giá trị của công thức: = IF(AND(A1>B1,D1>C1),2,3) 

A. 1                     B. 3.                        C. 2.       D. Công thức có lỗi cú pháp. 

Câu 22: Hãy cho biết kết quả của công thức: = SUM (B1:B5) 

A. 18.                     B. 35.                        C. 19.                        D.16. 
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Câu 23: Hãy cho biết giá trị của công thức sau:= MONTH(E6) 

A. VALUE#?                    B. 12.                     C. 3.                         D. 2. 

Câu 24: Cho biết kết quả của công thức: = MOD(B3,3) 

A. 1.                       B. 7.                     C. 3.                    D. 2. 

Câu 25: Cho biết kết quả của công thức: = AVERAGE (D1:D5) 

A.3.                              B. 3.5.                         C. 2.                        D. 5. 

Câu 26: Hãy cho biết kết quả của công thức: 

=IF(MIN(A2:A5)<AVERAGE(B1:D1);COUNT(B1:C5);MAX(MOD(A2;B2)*5;B5)) 

A. 1.                               B.5.                          C.11.                    D.10. 

Câu 27: Hãy cho biết kết quả của công thức: 

=IF(RIGHT(F3;3)=105;110;IF(VALUE(MID(F3;2;3))=105;RIGHT(F3;3)/7;100)) 

A. 105.                          B.110.                       C. 100.                D. 15. 

Câu 28: Nhập công thức nào sau đây cho kết quả là chữ A 

A. LEFT(F1,1).  B. RIGHT(F1,1).  

C. MID(F1,2,1). D. LEFT(F2,1). 

Câu 29: Nhập công thức nào sau đây cho kết quả là 6 

A. AVERAGE(C2:C4) B. LEN (E3)*2. 

C. MAX(C1:D3. D. AVERAGE (C2:C5). 

Câu 30: Cho biết kết quả của công thức: 

=IF(YEAR(F6)>A1;DAY(F6);MONTH(F6)) 

A. 4.                            B. 26.                      C. 5.                      D.35. 

Câu 31: Tại ô G2 có nhập công thức = 2*B$1-$C2 và hiển thị giá trị là 2. 

Khi sao chép công thức này đến ô H1. Thì tại ô này có giá trị là bao nhiêu ? 

A. 2.                           B. 4.                       C. 0.              D. -2. 

Câu 32: Cho biết kết quả của công thức sau: 

=HLOOKUP(LEFT(F1,1),$A$7:$C$8,2,0) 

A. 10.                         B. 20.                             C. 30.                  D. #N/A. 
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Câu 33: Cho biết kết quả của công thức sau khi thực hiện: 

=VLOOKUP(LEFT(F1,1),$E$7:$G$8,2,0) 

A. 10.                            B. 20.                       C.#N/A               D. 40. 

Câu 34: Cho biết kết quả của công thức sau: =E1&" "&E2 

A. HONG HUE. B. HONGHUE. 

C. HONG. D. Sai cú pháp. 

Câu 35: Cho biết kết quả của công thức sau: 

=COUNTIF($A$1:$A$5,">=10") 

A. 1.                   B.5.                      C. 4.                 D. 3. 

Câu 36: Cho biết kết quả của công thức sau: =LEN(E1) 

A. 1.                       B.5.                                C.6.                         D. 4. 

Câu 37: Cho biết kết quả của công thức sau: =RIGHT(F4;LEN(F4)-1) 

A.4321.            B.321.          C.D4321. D. Lỗi cú pháp. 

Câu 38. Để lựa chọn các vùng liền kề nhau trong bảng tính, bạn cần sử 

dụng chuột kết hợp với phím nào 

A. Ctrl  B. Ctrl và Shift  C. Alt   D. Shift 

Câu 39. Trong Excel, tại ô A2 có giá trị 0. Tại ô B2 gõ vào công thức 

=5/A2 thì nhận được kết quả: 

A. 0   B. 5    C. #VALUE!   D. #DIV/0! 

Câu 40. Khi gõ công thức xong rồi nhấn Enter, máy hiện ra #N/A có 

nghĩa là: 

A. Tham chiếu ô không hợp lệ       B. Giá trị tham chiếu không tồn tại 

C. Không tham chiếu đến được        D. Tập hợp rỗng 

Câu 41. Khi gõ công thức xong rồi nhấn Enter, máy hiện ra #REF! có 

nghĩa là: 

A. Tham chiếu ô không hợp lệ   B. Giá trị tham chiếu không tồn tại 

C. Không tham chiếu đến được   D. Tập hợp rỗng 
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Câu 42. Khi chọn trong mục Edit/ Paste Special chỉ mục Comments 

dùng để: 

A. Chép định dạng     B. Chép giá trị trong ô  

C. Chép bề rộng ô     D. Chép ghi chú 

Câu 43. Khi đang làm việc với Excel, có thể di chuyển từ sheet này sang 

sheet khác bằng cách sử dụng các phím hoặc các tổ hợp phím: 

A. Page Up, Page Down   B. Ctrl + Page Up, Ctrl + Page Down 

C. Cả A và B đều đúng   D.Cả A và B đều sai 

Câu 44. Trong Excel, hàm tính giá trị lớn nhất trong các ô thuộc khối ô 

C12:C15 là: 

A. Max C12:C15     B. Max(C12:C15)  

C. Max(C12,C15)     D. Max(C12;C15) 

Câu 45. Trong Excel, để lưu tập tin đang mở dưới một tên khác, ta chọn: 

A. File/ Save As  B. File/ Save      C. File/ New  D. Edit/ Replace 

Câu 46. Trong Excel, để xuống dòng trong một ô, ta sử dụng tổ hợp phím: 

A. Alt + Enter     B. Spacebar + Enter     C. Shift + Enter  D. Ctrl + Enter 

Câu 47. Trong Excel, để chèn thêm cột, ta chọn lệnh: 

A. Format/ Columns    B. Insert/ Rows  

C. Insert/ Columns    D. Insert/ Cells 

Câu 48. Trong Excel, để mở menu File, ta sử dụng tổ hợp phím: 

A. Ctrl + O      B. Ctrl + F          C. Alt + F        D. Alt + O 

Câu 49. Trong Excel, để bật tắt thanh công thức, ta dùng lệnh: 

A. View/ Formular bar    B. View/ Toolbars  

C. View/ Status bar     D. View/ Ruler 

Câu 50. Trong Excel, muốn kiểm tra phiên bản đang sử dụng, ta chọn: 

A. Help/ Microsoft Excel Help   B. Help/ About Microsoft Excel 

C. Tools/ Help     D. Edit/ Guide 
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Chương 4 

MICROSOFT POWERPOINT 

I. BÀI TẬP THỰC HÀNH  

BÀI 1: Làm quen với PowerPoint 

Mục tiêu 

- Biết khởi động phần mềm PowerPoint. 

- Biết tạo mới và lưu một bài trình chiếu. 

Yêu cầu của bài thực hành 

- Khởi động và làm quen với môi trường làm việc của PowerPoint. 

- Tạo một bài trình chiếu mới. 

- Đặt hình nền cho bài trình chiếu. 

- Lưu bài trình chiếu lên bộ nhớ ngoài và đóng bài trình chiếu. 

- Mở lại bài trình chiếu đã tạo. 

BÀI 2: Dùng PowerPoint để soạn một bài trình chiếu để giới thiệu về 

bản thân. 

Mục tiêu 

- Biết cách thêm slide mới vào bài trình chiếu. 

- Biết cách định dạng phông chữ, định dạng đoạn, lề trong hộp văn bản trên 

trang chiếu. 

- Biết cách thêm một số đối tượng vào trang chiếu như hộp văn bản, chữ 

nghệ thuật, tiêu đề trên, tiêu đề dưới, số trang, hình vẽ, tranh ảnh, bảng 

biểu, âm thanh; đồng thời hiệu chỉnh vị trí, kích thước và một số các 

thuộc tính khác của các đối tượng đó. 

Yêu cầu của bài thực hành 

- Bài trình chiếu được lưu lên bộ nhớ ngoài với tên tệp là Bai2.pptx. 

- Bài trình chiếu gồm 7 slide được đánh số trang và chọn tên tác giả là nội 

dung của tiêu đề dưới của các slide.  
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- Slide 1 gồm tiêu đề: “Giới thiệu về bản thân” viết bằng chữ nghệ thuật, 

phía dưới có đề tên tác giả. Ví dụ như sau: 

 

- Slide 2 khái quát về nội dung sẽ được trình bày trong bài trình chiếu; 

gồm thông tin cá nhân, sở thích, thành tích học tập/công việc, quê quán. 

 

- Slide 3 có nội dung ghi trong hai cột: một cột chèn một bức ảnh của bản 

thân, một cột ghi các thông tin: Họ và tên, ngày tháng năm sinh, quê 

quán, khoa, lớp, trường đang học.  

 

- Slide 4 có nội dung giới thiệu về sở thích bằng văn bản và có chèn hình 

ảnh hoặc bài hát minh họa cho sở thích. 
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- Slide 5 có nộ dung giới thiệu về kết quả học tập là một bảng điểm học tập 

gồm năm cột với tiêu đề cột là: STT, Tên môn học, Điểm điều kiện, 

Điểm cuối kỳ, Điểm trung bình môn. Các tiêu đề này được căn giữa trong 

cột tương ứng. Các dữ liệu trong các cột STT, Điểm điều kiện, Điểm cuối 

kỳ, Điểm trung bình môn được căn lề giữa, còn các dữ liệu trong cột Tên 

môn học được căn lề đều hai bên. 

 

- Slide 6 có nội dung giới thiệu về quê quán bằng cách chèn một đoạn clip 

tự làm. 

 

- Slide 7: Kết thúc bài giới thiệu hiển thị một lời chào với nội dung “Rất 

vui được làm quen với tất cả các bạn” viết bằng chữ nghệ thuật, và dùng 

công cụ vẽ hình trong PowerPoint để vẽ một hình mặt người cười. 
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BÀI 3: Thiết lập hiệu ứng cho các đối tượng, tạo liên kết cho các slide 

của bài trình chiếu 

Mục tiêu: 

- Biết cách tạo hiệu ứng cho các đối tượng có trên trang chiếu như hiệu ứng 

biến mất, hiệu ứng xuất hiện hay hiệu ứng nhấn mạnh. 

- Biết cách tạo liên lết cho các slide. 

Yêu cầu: 

- Mở tệp “Bai2.pptx” đã thiết kế trong Bài thực hành 2. 

- Tạo hiệu ứng xuất hiện cho các đối tượng trên từng slide (hiệu ứng tùy 

chọn). 

- Ở slide 2, mỗi nội dung được liên kết đến các slide tương ứng. 

 

- Ở slide 3, tên quê quán được liên kết tới slide 6 của bài thực hành, phần 

tên trường được liên kết tới website của trường. 
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- Dưới mỗi trang đều có các nút bấm: quay về slide  đầu, quay về slide vừa 

xem trước đó, chuyển đến slide tiếp theo và chuyển đến slide cuối cùng. 

Bài thực hành làm thêm 

Bài 4: Dùng chương trình Microsoft Office PowerPoint để tạo ra một bài 

giảng ngắn (khoảng 10 – 12 slide) mô tả các thao tác cơ bản khi dạy về phần 

mềm này. 

Bài 5: Anh (chị) dùng chương trình PowerPoint tạo một bài trình chiếu 

không quá 20 slide giới thiệu về trường Đại học Cảnh sát nhân dân. 

Bài 6: Anh (chị) dùng chương trình PowerPoint để soạn một bài giảng (từ 15 

– 20 slides) về một chủ đề có liên quan tới nội dung ngành học của anh (chị). 

II. CÂU HỎI TRẮC NGHIỆM 

Câu 1: Trong PowerPoint, thẻ Transitions để thực hiện 

A. Định dạng màu nền cho Slide. B. Hiệu ứng cho Auto Shapes. 

C. Hiệu ứng chuyển tiếp Slide. D. Trình diễn. 

Câu 2: Trong PowerPoint, phím chức năng nào để trình diễn từ slide 

đầu tiên: 

A. F4. B. F5. C. F6.  D. F10. 

Câu 3: Trong PowerPoint, thao tác nào cho phép thực hiện trình diễn từ 

slide hiện tại 

A. F5.                    B. Slide Show\Show.   

C. View\Slide show.               D. Kích   dưới khung bên phải. 

Câu 4: Trong PowerPoint, lệnh nào sau đây chèn thêm Slide mới trống 

A. Insert\Slide.  B. Insert\Duplicate Slide.  

C. Insert\New Slide.  D. Insert\ File. 

Câu 5: Trong PowerPoint, thẻ Animations để thực hiện 

A. Định font. B. Định màu nền. C. Tạo hiệu ứng.  D. Trình diễn. 

Câu 6: Khi sử dụng PowerPoint, nhấn tổ hợp phím Ctrl + N sẽ có tác dụng 

Le Hoai Duong
New Stamp



67 

A. Mở một tệp mới. B.  Chen vào một Slide mới. 

C. Di chuyển đến Slide đầu tiên. D.  Chen vào một siêu liên kết. 

Câu 7: Khi sử dụng  PowerPoint, nhấn phím shift đồng thời với phím F5 có 

tác dụng: 

A. Bắt đầu Show từ slide hiện hành. B. Lưu tệp đang soạn thảo vào đĩa. 

C. Chen vào một siêu liên kết. D. Bắt đầu Show từ slide 1. 

Câu 8: Trong PowerPoint 

A. Khi ta thay đổi font chữ của một slide thì font chữ trong một slide khác 

cũng thay đổi. 

B. Ta không thể thay đổi font chữ trong toàn bộ một slide. 

C. Ta không thể thay đổi màu của text.  

D  Cả ba câu (A), (B), (C) sai. 

Câu 9: Sau khi đã thiết kế xong bài trình diễn, cách làm nào sau đây không 

phải để trình chiếu ngay bài trình diễn đó? 

A. Chọn Slide Show -> Custom Show   B. Chọn Slide Show -> View Show 

C. Chọn View -> Slide Show                   D. Nhấn phím F5 

Câu 10: Thao tác chọn File -> Close dùng để 

A. lưu tập tin hiện tại  B. mở một tập tin nào đó 

C. Đóng tập tin hiện tại  D. thoát khỏi Powerpoint 

Câu 11: Sau khi đã chọn một đoạn văn bản, cách nào sau đây không phải 

để làm mất đi đoạn văn bản đó? 

A. Nhấn tổ hợp phím Alt + X. 

B. Nhắp chuột trái vào nút lệnh Cut (biểu tượng là cái kéo) trên thanh 

công cụ. 

C. Nhấn phím Delete.  

D. Chọn Edit ->  Cut. 
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Câu 12: Đang trình chiếu một bài trình diễn, muốn dừng trình diễn ta 

nhấn phím 

A. Tab   B. Esc  

C. Home   D. End 

Câu 13: Muốn mở một tập tin đã tồn tại trên đĩa, đầu tiên ta phải 

A. Chọn File -> Open  B. Chọn File -> New 

C. Chọn File -> Save  D. Chọn File -> Save As 

Câu 14: Để định dạng dòng chữ “Giáo án điện tử” thành “Giáo án điện tử” 

(kiểu chữ đậm, nghiêng, gạch dưới), toàn bộ các thao tác phải thực hiện là 

A. Đưa con trỏ văn bản vào giữa dòng chữ đó, nhấn Ctrl + U, Ctrl + I và 

Ctrl + B 

B. Đưa con trỏ văn bản vào giữa dòng chữ đó, nhấn Ctrl + B, Ctrl + U và 

Ctrl + I 

C. Chọn dòng chữ đó, nhấn Ctrl + U, Ctrl + I và Ctrl + B 

D. Nhấn Ctrl + U, Ctrl + I và  Ctrl + B 

Câu 15: Để lưu lại tập tin GADT.PPTX  đang mở, ta có thể 

A. Chọn File -> Save  

B. Chọn File -> Save As 

C. Chọn File -> Save hoặc File -> Save As đều được 

D. Chọn File -> Close 

Câu 16: Để hủy bỏ thao tác vừa thực hiện ta nhấn tổ hợp phím 

A. Ctrl + X B. Ctrl + Z 

C. Ctrl + C D. Ctrl + V 

Câu 17: Thao tác chọn File -> Open là để  

A. Mở một presentation đã có trên đĩa 

B. Tạo mới một presentation để thiết kế bài trình diễn 

C. Lưu lại presentation đang thiết kế 
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D. Lưu lại presentation đang thiết kế với một tên khác 

Câu 18: Trong khi thiết kế giáo án điện tử, thực hiện thao tác chọn Insert -> 

New Slide là để 

A. Chèn thêm một slide mới vào ngay trước slide hiện hành 

B. Chèn thêm một slide mới vào ngay sau slide hiện hành 

C. Chèn thêm một slide mới vào ngay trước slide đầu tiên 

D. Chèn thêm một slide mới vào ngay sau slide cuối cùng 

Câu 19: Để tạo một slide giống hệt như slide hiện hành mà không phải thiết 

kế lại, người sử dụng 

A. Chọn Insert -> Duplicate B. Chọn Insert -> New Slide 

C. Chọn Insert -> Duplicate Slide D. Không thực hiện được 

Câu 20: Để căn lề cho một đoạn văn bản nào đó trong giáo án điện tử đang 

thiết kế, trước tiên ta phải 

A. Đưa con trỏ văn bản vào giữa đoạn văn bản cần căn lề 

B. Chọn cả đoạn văn bản cần căn lề 

C. Chọn một dòng bất kỳ trong đoạn văn bản cần căn lề 

D. Cả 3 cách nêu trong câu này đều đúng 

Câu 21: Muốn xóa slide hiện thời khỏi giáo án điện tử, người thiết kế phải 

A. Chọn tất cả các đối tượng trên slide và nhấn phím Delete. 

B. Chọn tất cả các đối tượng trên slide và nhấn phím Backspace. 

C. Chọn Edit -> Delete Slide. 

D. Nhấn chuột phải lên slide và chọn Delete. 

Câu 22: Để lưu một đoạn văn bản đã được chọn vào vùng nhớ đệm 

(clipboard) mà không làm mất đi đoạn văn bản đó ta nhấn tổ hợp phím 

A. Ctrl + X B. Ctrl + Z 

C. Ctrl + C D. Ctrl + V 
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Câu 23: Đang thiết kế giáo án điện tử, trước khi thoát khỏi PowerPoint nếu 

người sử dụng chưa lưu lại tập tin thì máy sẽ hiện một thông báo. Để lưu lại tập 

tin này ta sẽ kích chuột trái vào nút nào trong bảng thông báo này? 

A. Nút Yes B. Nút No  

C. Nút Cancel D. Nút Save 

Câu 24: Muốn sao chép một phần của đoạn văn bản trong một Text Box, 

ta phải 

A. Chọn phần văn bản cần sao chép, nhấn Ctrl + C rồi đưa con trỏ văn bản 

đến vị trí cần sao chép, nhấn Ctrl + V 

B. Chọn phần văn bản cần sao chép, nhấn Ctrl + V rồi đưa con trỏ văn bản 

đến vị trí cần sao chép, nhấn Ctrl + C 

C. Chọn Text Box chứa đoạn văn bản đó, nhấn Ctrl + C rồi đưa con trỏ văn 

bản đến vị trí cần sao chép, nhấn Ctrl + V 

D. Chọn Text Box chứa đoạn văn bản đó, nhấn Ctrl + V rồi đưa con trỏ văn 

bản đến vị trí cần sao chép, nhấn Ctrl + C 

Câu 25: Khi thực hiện thao tác chọn Insert -> Movies and Sounds người 

sử dụng  

A. Chỉ được phép chèn hình ảnh vào giáo án 

B. Chỉ được phép chèn âm thanh vào giáo án 

C. Chỉ được phép chèn phim vào giáo án 

D. Có thể chèn âm thanh hoặc phim vào giáo án 

Câu 26: Sau khi đã chọn một số đối tượng trên slide hiện hành, nhấn tổ hợp 

phím nào sau đây sẽ làm mất đi các đối tượng đó?  

A. Alt + X B. Shift + X 

C. Ctrl + X D. Ctrl + Shift + X 

Câu 27: Thực hiện thao tác chọn Slide Show -> Custom Animation là để 

A. Tạo hiệu ứng động cho một đối tượng trong slide 

B. Tạo hiệu ứng chuyển trang cho các slide trong bài trình diễn  
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C. Đưa hình ảnh hoặc âm thanh vào bài trình diễn 

D. Định dạng cách bố trí các khối văn bản, hình ảnh, đồ thị ... cho một slide 

Câu 28: PowerPoint cho phép người sử dụng thiết kế một slide chủ chứa 

các định dạng chung của toàn bộ các slide trong bài trình diễn. Để thực hiện điều 

này, người dùng phải 

A. chọn Insert -> Master Slide 

B. chọn Insert -> Slide Master 

C. chọn View -> Master -> Slide Master 

D. chọn View -> Slide Master 

Câu 29: Chọn câu sai trong các câu sau, Trong khi thiết kế giáo án điện tử 

bằng PowerPoint,  

A. Không thể tạo chỉ số trên (ví dụ số 2 trong X2) như trong MS-Word 

B. Có thể sao chép (copy/paste) một đoạn văn bản từ tập tin Word sang   

C. Có thể dùng WordArt để tạo chữ nghệ thuật trang trí cho giáo án 

D. Có thể chèn các biểu đồ vào giáo án điện tử 

Câu 30: Máy tính đang kết nối Internet, sử dụng siêu liên kết (Hyperlink) 

sẽ cho phép người dùng liên kết đến 

A. Chỉ các tập tin có sẵn trong các ổ đĩa của máy tính đang soạn thảo 

B. Chỉ các slide đã có trong giáo án đang soạn thảo 

C. Chỉ các trang Web có trên mạng 

D. Tất cả các tập tin, các slide đã có trong máy và các trang Web 

Câu 31: Muốn mở một tập tin đã tồn tại trên đĩa, sau khi khởi động 

PowerPoint ta nhấn tổ hợp phím 

A. Ctrl + O B. Ctrl + N   

C. Ctrl + S D. Ctrl + C 

Câu 32: Khi đang trình chiếu (Slide Show) một bài trình diễn, muốn 

chuyển sang màn hình của một  chương trình ứng dụng khác (đã mở trước) để 

minh họa mà không kết thúc việc trình chiếu, ta phải 
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A. Nhấn tổ hợp phím Ctrl + Tab B. Nhấn tổ hợp phím Shift + Tab 

C. Nhấn tổ hợp phím Alt + Tab D. Nhấn tổ hợp phím Esc + Tab 

Câu 33: Chọn phát biểu sai: 

A. Khi tạo hiệu ứng động cho một khối văn bản ta có thể cho xuất hiện lần 

lượt từng từ trong khối văn bản khi trình chiếu 

B. Sau khi đã tạo hiệu ứng động cho một đối tượng nào đó ta không thể 

thay đổi kiểu hiệu ứng cho đối tượng đó 

C. Có thể thực hiện hiệu ứng chuyển trang cho 1 slide bất kỳ trong bài 

trình diễn 

D. Có thể thực hiện hiệu ứng chuyển trang cho tất cả các slide trong bài 

trình diễn 

Câu 34: Âm thanh đưa vào bài trình diễn  

A. Thực hiện được chỉ khi tạo hiệu ứng động cho đối tượng trong slide. 

B. Thực hiện được chỉ khi tạo hiệu ứng chuyển trang giữa các slide. 

C. Thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

D. Không thực hiện được cả khi tạo hiệu ứng động và hiệu ứng 

chuyển trang. 

Câu 35. Sau khi thiết kế xong bài trình diễn, cách nào sau đây không phải 

để trình chiếu ngay bài trình diễn đó? 

A. Nhấn phím F5                     B. Chọn Slide Show -> Chọn Cusstom Show 

C.  Chọn View -> Chọn Slide Show D.  Chọn Slide Show -> Chon 

View Show 

Câu 36. Muốn xoá đi một cột bảng biểu trong Slide hiện hành ta thực 

hiện lệnh: 

A.  Chọn cột đó, nhấn chuột phải lên vùng đã chọn và chọn Delete columns 

B.  Nhấn chụôt phải lên vùng bất kỳ thuộc cột đó và nhấn phím Delete 

C.  Đưa trỏ vào văn bản vào ô bất kỳ thuộc cột đó và nhấn phím Delete 

D.  Chọn cột đó, nhấn chuột phải lên vùng đã chọn và nhấn phím Delete 

Le Hoai Duong
New Stamp



73 

Câu 37. Để huỷ bỏ thao tác vừa thực hiện ta nhấn tổ hợp phím: 

A.  CTRL+Z B.  CTRL+C  

C.  CTRL+X D.  CTRL+V  

Câu 38. Để đưa họ tên của mình vào cuối mỗi slide làm tiêu đề chân trang, 

người thiết kế phải: 

A.  Chọn view -> chọn Header and Footer-> Chọn thẻ Slide, nhập họ tên 

vào hộp thoại FOOTER và nhấn Apply to All. 

B.  Chọn Chọn view -> chọn Header and Footer-> Chọn thẻ Slide, nhập họ 

tên vào hộp thoại FOOTER và nhấn Apply 

C.  Chọn Insert -> chọn Header and Footer-> Chọn thẻ Slide, nhập họ tên 

vào hộp thoại FOOTER và nhấn Apply to All 

D.  Chọn Insert -> chọn Header and Footer-> Chọn thẻ Slide, nhập họ tên 

vào hộp thoại FOOTER và nhấn Apply  

Câu 39. Tại một Slide hiện hành ta bấm delete (trên bàn phím) lệnh này sẽ: 

A.  Thêm slide B.  Thêm slide hiện thời  

C.  Xoá slide đó D.  không thực hiện  

Câu 40. Để tạo một slide giống hệt slide hiện hành mà không phải thiết kế 

lại, người sử dụng cần chọn: 

A.  Vào Insert -> chọn New slide B.  Vào Insert -> chọn Duplicate 

C. Vào Insert-> chọn Duplicate slide D. Không thực hiện được  

Câu 41. Thêm 1 slide rỗng ta thực hiện: 

A.  Insert-> Tab B.  Insert -> Picture slide  

C.  Insert-> new slide D.  Insert-> duplicate slide  

Câu 42. Sau khi thiết kết song một giáo án điện tử, do số lượng slide quá 

nhiều, nếu anh (chị) muốn in 6 slide trên 1 trang ta thực hiện lệnh nào sau đây ? 

A.  Chọn File-> chọn print -> Chọn Print Whats -> Chọn Handouts 

B.  Chọn Format -> print whats-> Chọn Handouts   

C.  Chọn File ->chọn print ->Chọn Handouts     
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D.  Chọn Insert ->Chọn  print whats-> Chọn Handouts   

Câu 43. Muốn chữ  “Powerpoint” trong một văn bản định dạng thành “ 

Powerpoint” ta:  

A.  Chỉ bôi đen chữ Power nhấn tổ hợp phím CTRL+U.  

B.  Nhấn tổ hợp phím CTRL+U+B  

C. Đưa con trỏ văn bản đến chữ “Powerpoint” và nhấn tổ hợp phím 

CTRL+U 

D.  Nhấn tổ hợp phím CTRL+B 

Câu 44. Muốn xoá Slide hiện thời khỏi giáo án điện tử, người thiết kế phải: 

A.  Chọn Edit -> Chon Delete Slide  

B.  Chọn tất cả các đối tượng trên Slede và nhấn Backspace. 

C.  Nhấn chuột phải lên slide và chọn Delete Slide  

D.  Chọn tất cả các đối tượng trên Slide và nhấn Delete 

Câu 45. Để thiết lập thông số trang in ta tực hiện  

A.  Chọn File -> Chọn Preview B.  Chọn File -> Chọn Properties 

C.  Chọn File -> Chọn Page Setup D. Chọn File -> Chọn print 

Câu 46. Sau khi chọn Format -> chọn Slide Design, nếu chọn một mẫu 

(Design Template) nào đó để tạo kiểu thiết kế chung cho các slide thì sau đó người 

sử dụng: 

A.  Không thể định dạng màu chữ, kiểu chữ trong slide. 

B.  Chỉ có thể thay đổi kiểu thiết kế cho tất cả các slide. 

C.  Có thể thay đổi kiểu thiết kế cho từng Slide. 

D.  Không thể định dạng màu hoặc hoa văn trong Slide. 

Câu 47. Khi tạo hiệu ứng động cho 2 đối tượng A và B trong một Slide, 

người thiết kế đã xác lập thời gian để B tự động xuất hiện sau A là 5 giây. Vậy 

khi trình chiếu: 

A. Khi A đã xuất hiện, cứ 5 giây sau thì B Xuất hiện 1 lần  
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B. Sau khi A xuất hiện nếu người sử dụng nhấp chuột thì B lập tức 

xuất hiện  

C. B luôn luôn xuất hiện sau A là 5 giây khi người sử dụng có nhấp chuột 

hay không 

D. Khi A đã xuất hiện nếu người sử dụng nhấp chuột thì 5 giây sau B mới 

xuất hiện. 

Câu 48. Thao tác chọn Slide Show -> Custom Animation là để tạo 

hiệu ứng: 

A.  Chỉ cho đối tượng là khối văn bản      

B.  Chỉ cho đối tượng là khối văn bản và hình ảnh 

C.  Chỉ cho đối tượng là hình ảnh.  

D.  Cho tất cả các đối tượng 

Câu 49. Lệnh từ tổ hợp phím CTRL+N trong chương trình Microsoft 

Powerpoint nhằm để: 

A.  Không thực hiện được B.  Mở Presentation đã có  

C.  Đóng 1 Presentation D.  Tạo Presentation mới 

Câu 50. Vào Slide show -> Slide Transition -> Chọn Automaticcally after 

00:05 giây bấm Apply to all slide sẽ thực hiện được lệnh trình chiếu: 

A. Mỗi Slide được trình chiếu 00:05 giây bắt đầu từ Slide hiện hành được 

trình chiếu. 

B. Chỉ cần kích chuột một lần Slide được trình chiếu 00:05 giây bắt đầu từ 

Slide hiện hành được trình chiếu 

C. Các Slide không tự động trình chiếu. 

D. Các Slide phải tuân thủ sự theo trình tự là trình chiếu lâu hơn 00:05 giây 
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